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Updated Information

This vSphere Upgrade Guide is updated with each release of the product or when necessary.

This table provides the update history of the vSphere Upgrade Guide.

Revision Description

EN-000310-03 n Included a topic, “DNS Requirements for vSphere,” on page 22 in System Requirements section.
n Minor change in, “Requirements for Creating Virtual Machines,” on page 20 section.
n Modified a point in “vSphere Components Upgraded by Update Manager,” on page 67 section.
n Modified a point in “Preserved Configuration Components,” on page 67 section.
n Removed a step from the “Back Up the ESX Host Configuration,” on page 69 section

EN-000310-02 n Made a variety of changes specific to vSphere 4.1 Update 1, including updating the topics: “vCenter
Server Upgrade Summary,” on page 25, “Database Scenarios,” on page 31, and “Release Upgrade
Support for ESX/ESXi,” on page 64.

n Added cautionary wording to Chapter 9, “Upgrading to ESX 4.1 or ESXi 4.1,” on page 71 indicating
that upgrades from ESX 3.x to ESX 4.x fail to replicate customized partitions.

EN-000310-01 Added notes to “vCenter Server Upgrade Summary,” on page 25 referencing vCenter Server release notes.

EN-000310-00 Initial release.
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About This Book

The vSphere Upgrade Guide describes how to upgrade from earlier versions of VMware® ESX™, ESXi, and
VMware vCenter™ Server to ESX 4.1/ESXi 4.1 and vCenter Server 4.1.

This guide includes the following tasks:

n Upgrade to vCenter Server 4.1 from vCenter Server 4.0.

n Install vCenter Server 4.1 on a different machine and keep a VirtualCenter 2.5 or higher database. You
would do this if you are upgrading from a 32-bit server to a 64-bit server, for example.

n Upgrade to ESX 4.1/ESXi 4.1 from ESX 4.0/ESXi 4.0.

n Upgrade VMware Tools and virtual hardware.

To learn how to simplify and automate your datacenter upgrade, see the vSphere Update Manager Administration
Guide.

If you have legacy versions of ESX, ESXi, and VirtualCenter, and you want to migrate to
VMware vSphere™ 4.1 by performing fresh installations that do not preserve existing data, see the following
manuals:

n ESX and vCenter Server Installation Guide

n ESXi Installable and vCenter Server Setup Guide

n ESXi Embedded and vCenter Server Setup Guide

Intended Audience
This book is intended for anyone who needs to upgrade from earlier versions of ESX/ESXi and vCenter Server
to ESX 4.1/ESXi 4.1 and vCenter Server 4.1. The information in this manual is written for experienced Microsoft
Windows or Linux system administrators who are familiar with virtual machine technology and datacenter
operations.

VMware Technical Publications Glossary
VMware Technical Publications provides a glossary of terms that might be unfamiliar to you. For definitions
of terms as they are used in VMware technical documentation, go to http://www.vmware.com/support/pubs.

Document Feedback
VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

VMware, Inc.  9

http://www.vmware.com/support/pubs
mailto:docfeedback@vmware.com


VMware vSphere Documentation
The vSphere documentation consists of the combined VMware vCenter Server and ESX/ESXi documentation
set.

Technical Support and Education Resources
The following technical support resources are available to you. To access the current version of this book and
other books, go to http://www.vmware.com/support/pubs.

Online and Telephone
Support

To use online support to submit technical support requests, view your product
and contract information, and register your products, go to 
http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support
for the fastest response on priority 1 issues. Go to 
http://www.vmware.com/support/phone_support.html.

Support Offerings To find out how VMware support offerings can help meet your business needs,
go to http://www.vmware.com/support/services.

VMware Professional
Services

VMware Education Services courses offer extensive hands-on labs, case study
examples, and course materials designed to be used as on-the-job reference
tools. Courses are available onsite, in the classroom, and live online. For onsite
pilot programs and implementation best practices, VMware Consulting
Services provides offerings to help you assess, plan, build, and manage your
virtual environment. To access information about education classes,
certification programs, and consulting services, go to 
http://www.vmware.com/services.
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About the Upgrade Process 1
Upgrading is a multistage process in which procedures must be performed in a particular order. Follow the
suggested process to ensure a smooth upgrade with a minimum of system downtime.

CAUTION   VMware recommends that you read about the upgrade process before attempting to upgrade. If you
do not follow appropriate safeguards, you might lose data and lose access to your servers. Without planning,
you might incur more downtime than is necessary.

You must complete the upgrade process in a specific order because you can lose data and server access. Order
is also important within each upgrade stage.

You can perform the upgrade process for each component in only one direction. For example, after you upgrade
to vCenter Server, you cannot revert to VirtualCenter 2.5. However, with appropriate backups and planning,
you can restore your original software records.

You can take any amount of time to complete each of the upgrade procedures. Keep in mind the following
considerations:

n You must complete one procedure before you move to the next procedure.

n Some major procedures include minor substeps. Follow the directions within each procedure regarding
the required sequence of minor substeps.

Because certain commands can simultaneously upgrade more than one stage, VMware recommends that you
thoroughly understand the irreversible changes at each stage before you upgrade your production
environments.

To ensure that your datacenter upgrade goes smoothly, you can use vCenter Update Manager to manage the
process for you.
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System Requirements 2
Systems running vCenter Server and ESX/ESXi instances must meet specific hardware and operating system
requirements.

This chapter includes the following topics:

n “ESX Hardware Requirements,” on page 13

n “ESXi Hardware Requirements,” on page 16

n “vCenter Server and the vSphere Client Hardware Requirements,” on page 18

n “vCenter Server Software Requirements,” on page 19

n “vSphere Client Software Requirements,” on page 20

n “Support for 64-Bit Guest Operating Systems,” on page 20

n “Requirements for Creating Virtual Machines,” on page 20

n “Required Ports,” on page 21

n “DNS Requirements for vSphere,” on page 22

n “Supported Remote Management Firmware Versions,” on page 22

ESX Hardware Requirements
Using ESX requires specific hardware and system resources.

64-Bit Processor
n VMware ESX 4.1 will install and run only on servers with 64-bit x86 CPUs.

n Known 64-bit processors:

n All AMD Opterons support 64 bit.

n All Intel Xeon 3000/3200, 3100/3300, 5100/5300, 5200/5400, 7100/7300, and 7200/7400 support 64 bit.

n All Intel Nehalem (no Xeon brand number assigned yet) support 64 bit.

RAM
2GB RAM minimum

For upgrades, 3GB RAM is required if the ESX host is managed by vCenter Server.
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Network Adapters
One or more network adapters. Supported network adapters include:

n Broadcom NetXtreme 570x gigabit controllers

n Intel PRO 1000 adapters

SCSI Adapter, Fibre Channel Adapter, or Internal RAID Controller
One or more of the following controllers (any combination can be used):

n Basic SCSI controllers are Adaptec Ultra-160 and Ultra-320, LSI Logic Fusion-MPT, and most
NCR/Symbios SCSI controllers.

n Fibre Channel, see the Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

n RAID adapters supported are HP Smart Array, Dell PERC (Adaptec RAID and LSI MegaRAID), and IBM
(Adaptec) ServeRAID controllers.

Installation and Storage
n SCSI disk, Fibre Channel LUN, or RAID LUN with unpartitioned space. In a minimum configuration, this

disk or RAID is shared between the service console and the virtual machines.

n For hardware iSCSI, a disk attached to an iSCSI controller, such as the QLogic qla405x. Software iSCSI is
not supported for booting or installing ESX.

n Serial attached SCSI (SAS).

n For Serial ATA (SATA), a disk connected through supported SAS controllers or supported on-board SATA
controllers. SATA disk drives connected behind supported SAS controllers or supported on-board SATA
controllers.

n Supported SAS controllers include:

n LSI1068E (LSISAS3442E)

n LSI1068 (SAS 5)

n IBM ServeRAID 8K SAS controller

n Smart Array P400/256 controller

n Dell PERC 5.0.1 controller

n Supported on-board SATA controllers include:

n Intel ICH9

n NVIDIA MCP55

n ServerWorks HT1000

When installing ESX on SATA drives, consider the following:

n Ensure that your SATA drives are connected through supported SAS controllers or supported onboard
SATA controllers.

n ESX does not support using local, internal SATA drives on the host server to create VMFS datastores that
are shared across multiple ESX hosts.

ATA and IDE disk drives – ESX supports installing and booting on either an ATA drive or ATA RAID, but
ensure that your specific drive controller is included in the supported hardware. IDE drives are supported for
ESX installation and VMFS creation.
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Recommendations for Enhanced ESX Performance
You can enhance ESX performance by using multiple physical disks, such as SCSI disks, Fibre Channel LUNs,
and RAID LUNs.

Listed here are recommendations for enhanced performance.

RAM The ESX host might require more RAM for the service console if you are
running third-party management applications or backup agents.

Network adapters for
virtual machines

Dedicated Gigabit Ethernet cards for virtual machines, such as Intel PRO 1000
adapters, improve throughput to virtual machines with high network traffic.

Disk location For best performance, store all data used by your virtual machines on physical
disks allocated to virtual machines. These physical disks should be large
enough to hold disk images used by all the virtual machines.

Processors Faster processors improve ESX performance. For certain workloads, larger
caches improve ESX performance.

Hardware compatibility Use devices in your server that are supported by ESX 4.1 drivers. See the
Hardware Compatibility Guide at 
http://www.vmware.com/resources/compatibility.

Tested Software and Firmware for Creating ESX Installation Media
Before you install ESX, you might need to burn the ESX installation ISO image onto DVD or USB media. Review
the firmware and software that VMware has tested and has confirmed works.

VMware has tested these combinations.

Table 2-1 lists the tested combinations for burning the ESX installation ISO image onto DVD media.

Table 2-1.  Tested Combinations for DVD

DVD Drive (Make, Model, and BIOS) Software to Burn DVD DVD Media

Phillips + RW DVD8801 Roxio Creator Classic version: 6.1.1.48 SONY DVD +RW 120min / 4.7 GB

Philips PLDS DVD + RW DH-16A6S Roxio Creator version: 3.3.0 SONY DVD+RW

Philips PLDS DVD + RW DH-16W1S Roxio Creator version: 3.3.0 SONY DVD+RW

Philips BenQ PBDS + RW DH-16W1S Roxio Creator version: 3.3.0 SONY DVD+RW

HL-DT-ST DVD+-RW GSA-H53N Burn4Free V.4.6.0.0 SONY DVD+RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Memorex DVD-R

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Office Depot DVD+RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 Ativa DVD-RW

Dell/_NEC DVD +-RW ND-3530A Roxio Creator Classic version: 6.1.1.48 TDK DVD+R
Verbatim DVD+R
SONY DVD-R
Maxell DVD+R

Table 2-2 lists the tested combinations for burning the ESX installation ISO image onto USB media.

Chapter 2 System Requirements
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Table 2-2.  Tested Combinations for USB

External USB DVD Drive Firmware Version

Iomega Rev: XY13

LaCie Rev: LA00

LG 8x portable DVD Rewriter Rev: KE01

SONY DVD+- R 20X Rev: SS01

ESXi Hardware Requirements
Make sure the host meets the minimum hardware configurations supported by ESXi 4.1.

You need the following hardware and system resources to install and use ESXi 4.1:

n Supported server platform (for a list of supported platforms, see the Systems Compatibility Guide)

n VMware ESXi 4.1 will install and run only on servers with 64-bit x86 CPUs.

n Known 64-bit processors:

n All AMD Opterons support 64 bit.

n All Intel Xeon 3000/3200, 3100/3300, 5100/5300, 5200/5400, 7100/7300, and 7200/7400 support 64 bit.

n All Intel Nehalem (no Xeon brand number assigned yet) support 64 bit.

n 2GB RAM minimum. For upgrades, 3GB RAM is required if the ESXi host is managed by vCenter Server.

n One or more Gigabit or 10Gb Ethernet controllers. For a list of supported network adapter models, see the
Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

n One or more of the following controllers (any combination can be used):

n Basic SCSI controllers – Adaptec Ultra-160 or Ultra-320, LSI Logic Fusion-MPT, or most NCR/Symbios
SCSI.

n RAID controllers – Dell PERC (Adaptec RAID or LSI MegaRAID), HP Smart Array RAID, or IBM
(Adaptec) ServeRAID controllers.

n SCSI disk or a local (non-network) RAID LUN with unpartitioned space for the virtual machines.

n For Serial ATA (SATA), a disk connected through supported SAS controllers or supported on-board SATA
controllers.

NOTE   You cannot connect a SATA CD-ROM device to a virtual machine on an ESXi 4.1 host. To use the
SATA CD-ROM device, you must use IDE emulation mode.

ESXi 4.1 Installable supports installing on and booting from the following storage systems:

n SATA disk drives – SATA disk drives connected behind supported SAS controllers or supported on-board
SATA controllers.

Supported SAS controllers include:

n LSI1068E (LSISAS3442E)

n LSI1068 (SAS 5)

n IBM ServeRAID 8K SAS controller

n Smart Array P400/256 controller

n Dell PERC 5.0.1 controller
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Supported on-board SATA include:

n Intel ICH9

n NVIDIA MCP55

n ServerWorks HT1000

NOTE   ESX does not support using local, internal SATA drives on the host server to create VMFS datastores
that are shared across multiple ESX hosts.

n Serial Attached SCSI (SAS) disk drives – Supported for installing ESXi 4.1 and for storing virtual machines
on VMFS partitions.

n Fibre Channel or iSCSI

n USB devices – Supported for installing ESXi 4.1. For a list of supported USB devices, see the Hardware
Compatibility Guide at http://www.vmware.com/resources/compatibility.

Recommendation for Enhanced ESXi Performance
To enhance performance, VMware recommends that you install ESXi on a robust system with more RAM than
the minimum required and with multiple physical disks.

Consider the following recommendations for enhanced performance:

n RAM – ESXi 4.1 hosts require more RAM than typical servers. An ESXi 4.1 host must be equipped with
sufficient RAM to run concurrent virtual machines.

For example, operating four virtual machines with Red Hat Enterprise Linux or Windows XP requires at
least 3GB of RAM for baseline performance. This includes approximately 1024MB for the virtual machines
(256MB minimum for each operating system as recommended by vendors).

Running these four virtual machines with 512MB RAM requires that the ESXi 4.1 host be equipped with
approximately 4GB RAM, which includes 2048MB for the virtual machines.

These calculations do not take into account possible memory savings from using variable overhead
memory for each virtual machine. See the Resource Management Guide.

n Dedicated Fast Ethernet adapters for virtual machines – Place the management network and virtual
machine networks on different physical network cards. Dedicated Gigabit Ethernet cards for virtual
machines, such as Intel PRO 1000 adapters, improve throughput to virtual machines with high network
traffic.

n Disk location – Place all data used by your virtual machines on physical disks allocated specifically to
virtual machines. Performance is better when you do not place your virtual machines on the disk
containing the ESXi 4.1 Installable boot image. Use physical disks that are large enough to hold disk images
used by all the virtual machines.

n VMFS3 partitioning – The ESXi 4.1 installer creates the initial VMFS volumes automatically on blank local
disks. To add disks or modify the original configuration, use the vSphere Client. This application ensures
that the starting sectors of partitions are 64K-aligned, which improves storage performance.

NOTE   For SAS-only environments, the installer might not format the disks. For some SAS disks, it is
difficult to identify whether the disks are local or remote. After the installation, you can use the vSphere
Client to set up VMFS.

n Processors – Faster processors improve ESXi 4.1 performance. For certain workloads, larger caches
improve ESXi 4.1 performance.

n Hardware compatibility – Use devices in your server that are supported by ESXi 4.1 drivers. See the
Hardware Compatibility Guide at http://www.vmware.com/resources/compatibility.

Chapter 2 System Requirements
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vCenter Server and the vSphere Client Hardware Requirements
The vCenter Server system is a physical machine or virtual machine with access to a supported database. The
vCenter Server system must meet specific requirements. Also make sure that the vSphere Client machines meet
the hardware requirements.

Minimum Requirements for vCenter Server
n CPU – Two 64-bit CPUs or one 64-bit dual-core processor.

n Processor – 2.0GHz or faster Intel or AMD processor. Processor requirements might be higher if the
database runs on the same machine.

n Memory – 3GB RAM. Memory requirements might be higher if the database runs on the same machine.

vCenter Server includes a service called VMware VirtualCenter Management Webservices. This service
requires 512MB to 4.4GB of additional memory. The maximum Webservices JVM memory can be specified
during the installation depending on the inventory size.

n Disk storage – 3GB. Disk requirements might be higher if the database runs on the same machine.

n Microsoft SQL Server 2005 Express disk requirements – Up to 2GB free disk space to decompress the
installation archive. Approximately 1.5GB of these files are deleted after the installation is complete.

n Networking – Gigabit connection recommended.

NOTE   Installing vCenter Server on a network drive or USB flash drive is not supported.

See your database documentation for the hardware requirements of your database. The database requirements
are in addition to the vCenter Server requirements if the database and vCenter Server run on the same machine.

Minimum Requirements for the vSphere Client
n CPU – 1 CPU

n Processor – 500MHz or faster Intel or AMD processor (1GHz recommended)

n Memory – 1GB RAM

n Disk Storage – 1.5GB free disk space for a complete installation, which includes the following components:

n Microsoft .NET 2.0

n Microsoft .NET 3.0 SP1

n Microsoft Visual J#

Remove any previously installed versions of Microsoft Visual J# on the system where you are
installing the vSphere Client.

n vSphere Client 4.1

n vSphere Host Update Utility 4.1

If you do not have any of these components already installed, you must have 400MB free on the drive that
has the %temp% directory.

If you have all of the components already installed, 300MB of free space is required on the drive that has
the %temp% directory, and 450MB is required for vSphere Client 4.1.

n Networking – Gigabit connection recommended

vSphere Upgrade Guide
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System Recommendations for Performance Based on Deployment Size
The number of hosts and powered-on virtual machines in your environment affects performance. The
following system requirements should be used as minimum guidelines for reasonable performance. For
increased performance, you can configure systems in your environment with values greater than those listed
here.

Processing requirements are listed in terms of hardware CPU cores. Only physical cores are counted. In hyper-
threaded systems, logical CPUs do not count as separate cores.

IMPORTANT   The recommended disk sizes assume default log levels. If you configure more granular log levels,
more disk space is required.

Table 2-3 summarizes the requirements for a medium deployment.

Table 2-3.  Up to 50 Hosts and 500 Powered-On Virtual Machines

Product Cores Memory Disk

vCenter Server 2 4GB 5GB

vSphere Client 1 200MB 1.5GB

Table 2-4 summarizes the requirements for a large deployment.

Table 2-4.  Up to 300 Hosts and 3000 Powered-On Virtual Machines

Product Cores Memory Disk

vCenter Server 4 8GB 10GB

vSphere Client 1 500MB 1.5GB

Table 2-5 summarizes the requirements for an extra-large deployment.

Table 2-5.  Up to 1000 Hosts and 10000 Powered-On Virtual Machines

Product Cores Memory Disk

vCenter Server 8 16GB 10GB

vSphere Client 2 500MB 1.5GB

Requirements for Installing vCenter Server on a Custom Drive
If you install vCenter Server on any custom drive, note the following space requirements:

n 1GB on the custom drive for vCenter Server

n 1.13GB on the C:\ drive for Microsoft .NET 3.0 SP1, Microsoft ADAM, Microsoft SQL Server 2005 Express
(optional), and Microsoft Visual C++ 2008 Redistributable

n 375MB for the custom drive %temp% directory

vCenter Server Software Requirements
Make sure that your operating system supports vCenter Server. vCenter Server requires a 64-bit operating
system, and the 64-bit system DSN is required for vCenter Server to connect to its database.

For a list of supported operating systems, see the vSphere Compatibility Matrixes at 
http://www.vmware.com/pdf/vsphere4/r40/vsp_compatibility_matrix.pdf on the VMware vSphere
documentation Web site.

Chapter 2 System Requirements
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vSphere Client Software Requirements
Make sure that your operating system supports the vSphere Client.

For a list of supported operating systems, see the vSphere Compatibility Matrixes at 
http://www.vmware.com/pdf/vsphere4/r40/vsp_compatibility_matrix.pdf on the VMware vSphere
documentation Web site.

The vSphere Client requires the Microsoft .NET 3.0 SP1 Framework. If your system does not have it installed,
the vSphere Client installer installs it. The .NET 3.0 SP1 software might require Internet connectivity to
download additional files.

Support for 64-Bit Guest Operating Systems
ESX/ESXi offers support for several 64-bit guest operating systems.

See the Guest Operating System Installation Guide for a complete list.

Hosts running virtual machines with 64-bit guest operating systems have the following hardware
requirements:

n For AMD Opteron-based systems, the processors must be Opteron Rev E and later.

n For Intel Xeon-based systems, the processors must include support for Intel Virtualization Technology
(VT). Many servers that include CPUs with VT support might ship with VT disabled by default, so you
must enable VT manually. If your CPUs support VT but you do not see this option in the BIOS, contact
your vendor to request a BIOS version that lets you enable VT support.

To determine whether your server has 64-bit VMware support, you can download the CPU Identification
Utility at the VMware downloads page: http://www.vmware.com/download/shared_utilities.html.

Requirements for Creating Virtual Machines
To create a virtual machine, the ESX/ESXi host must be able to support a virtual processor, a virtual chip set,
and a virtual BIOS.

Each ESX/ESXi machine has the requirements shown in Table 2-6.

Table 2-6.  Requirements for Creating Virtual Machines

Component Requirements

Virtual processor One, two, four, or eight processors per virtual machine
NOTE   If you create a two-processor virtual machine, your ESXi machine must have
at least two physical core in processor.

Virtual chip set Intel 440BX-based motherboard with NS338 SIO chip

Virtual BIOS PhoenixBIOS 4.0 Release 6
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Required Ports
The VMware vCenter Server system must be able to send data to every managed host and receive data from
every vSphere Client. To enable migration and provisioning activities between managed hosts, the source and
destination hosts must be able to receive data from each other.

VMware uses designated ports for communication. Additionally, the managed hosts are listening for data from
the vCenter Server system on designated ports. If a firewall exists between any of these elements and Windows
firewall service is in use, the installer opens the ports during the installation. For custom firewalls, you must
manually open the required ports. If you have a firewall between two managed hosts and you want to perform
source or target activities, such as migration or cloning, you must configure a means for the managed hosts to
receive data.

NOTE   In Microsoft Windows Server 2008, a firewall is enabled by default.

Table 2-7 lists the default ports that are required for communication between components.

Table 2-7.  Required Ports

Port Description

80 vCenter Server requires port 80 for direct HTTP connections. Port 80 redirects requests to HTTPS port
443. This is useful if you accidentally use http://server instead of https://server.

389 This port must be open on the local and all remote instances of vCenter Server. This is the LDAP port
number for the Directory Services for the vCenter Server group. The vCenter Server system needs to
bind to port 389, even if you are not joining this vCenter Server instance to a Linked Mode group. If
another service is running on this port, it might be preferable to remove it or change its port to different
port. You can run the LDAP service on any port from 1025 through 65535.
If this instance is serving as the Microsoft Windows Active Directory, change the port number from 389
to an available port from 1025 through 65535.

443 The default port that the vCenter Server system uses to listen for connections from the vSphere Client.
To enable the vCenter Server system to receive data from the vSphere Client, open port 443 in the
firewall.
The vCenter Server system also uses port 443 to listen for data transfer from the vSphere Web Access
Client and other SDK clients.
If you use another port number for HTTPS, you must use <ip-address>:<port> when you log in to the
vCenter Server system.

636 For vCenter Linked Mode, this is the SSL port of the local instance. If another service is running on this
port, it might be preferable to remove it or change its port to different port. You can run the SSL service
on any port from 1025 through 65535.

902 The default port that the vCenter Server system uses to send data to managed hosts. Managed hosts
also send a regular heartbeat over UDP port 902 to the vCenter Server system. This port must not be
blocked by firewalls between the server and the hosts or between hosts.

902/903 Ports 902 and 903 must not be blocked between the vSphere Client and the hosts. These ports are used
by the vSphere Client to display virtual machine consoles.

8080 Web Services HTTP. Used for the VMware VirtualCenter Management Webservices.

8443 Web Services HTTPS. Used for the VMware VirtualCenter Management Webservices.

60099 Web Service change service notification port

If you want the vCenter Server system to use a different port to receive vSphere Client data, see the VMware
vSphere Datacenter Administration Guide.

For a discussion of firewall configuration, see the ESX Configuration Guide.
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DNS Requirements for vSphere
You can install vCenter Server, like any other network server, on a machine with a fixed IP address and well-
known DNS name, so that clients can reliably access the service.

Assign a static IP address and host name to the Windows server that will host the vCenter Server system. This
IP address must have a valid (internal) domain name system (DNS) registration.

Ensure that the ESXi host management interface has a valid DNS resolution from the vCenter Server and all
vSphere Clients and vSphere Web Clients. Ensure that the vCenter Server has a valid DNS resolution from all
ESXi hosts and all vSphere Clients and vSphere Web Clients. Ensure that the vCenter Server is installed on a
machine that has a resolvable fully qualified domain name (FQDN).

If you use DHCP instead of a static IP address for vCenter Server, make sure that the vCenter Server computer
name is updated in the domain name service (DNS). Ping the computer name to test the connection. For
example, if the computer name is host-1.company.com, you can ping the name by running the following
command in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.

Supported Remote Management Firmware Versions
You can use remote management applications for installing ESXESXi or for remote management of hosts.

Table 2-8 lists the remote management firmware versions that are supported for installing ESX  4.1 remotely.

Table 2-8 lists the remote management firmware versions that are supported for installing ESXi  4.1 remotely.

NOTE   If you are using a remote management application to access the ESXi direct console, consider enabling
high-contrast mode in the direct console by pressing F4.

Table 2-8.  Supported Remote Management Server Models and Firmware Versions

Remote Controller
Make and Model Firmware Version Java ActiveX

DRAC 5 1.4 Not applicable 1.4.2_19

1.45 (08.10.06) 2.1,0,14 1.6.0.50

1.40 (08.08.22) 2,1,0,14 1.6.0_11

1.20 (07.03.02) 1.4.2_06 2,1,0,13

1.33 1.6.0_07 2,1,0,14

1.32 (07.12.22) 1.4.2_13 2,1,0,13

1.0 (06.05.12) 1.4.2_13 2,1,0,13

1.32 1.6.0_11 2,1,0,14

1.2 1.6.0_11 2,1,0,14

1.45 (09.01.16) 1.6.0_11 2,1,0,14

1.3 1.6.0_11 2,1,0,14

1.33 1.6.0_11 2,1,0,13

DRAC 4 1.7 1.4.2_06 2,1,0,14

ILO .26 1.6.0_11 2,1,0,14

1.7 1.4.2_19 Not applicable

ILO2 1.91 (07/26/2009) 1.6.0_07 2,1,0,14
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Table 2-8.  Supported Remote Management Server Models and Firmware Versions (Continued)

Remote Controller
Make and Model Firmware Version Java ActiveX

1.29 (2/28/2007) 1.4.2_13 Not applicable

RSA 1.09 1.6.0_11 2,1,0,14

1.06 1.6.0_11 2,1,0,14
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Preparing for the Upgrade to vCenter
Server 3

Before you upgrade to vCenter Server, review the prerequisites.

This chapter includes the following topics:

n “About the vCenter Server 4.1 Upgrade,” on page 25

n “vCenter Server Upgrade Summary,” on page 25

n “Prerequisites for the vCenter Server Upgrade,” on page 27

n “vCenter Server Database Patch and Configuration Requirements,” on page 29

n “Database Scenarios,” on page 31

n “Configure vCenter Server to Communicate with the Local Database After Shortening the Computer
Name to 15 Characters or Fewer,” on page 32

n “Back Up VirtualCenter 2.5 or Higher,” on page 32

n “Run the vCenter Agent Preupgrade Check Tool,” on page 33

n “Downtime During the vCenter Server Upgrade,” on page 35

About the vCenter Server 4.1 Upgrade
VMware supports in-place upgrades on 64-bit systems from vCenter Server 4.0 to vCenter Server 4.1.

You can upgrade VirtualCenter 2.5 and vCenter Server 4.0 to vCenter Server 4.1 by installing vCenter Server
4.1 on a new machine and migrating the existing database. This upgrade method makes it possible to upgrade
from a 32-bit system to a 64-bit system.

vCenter Server 4.1 can manage ESX 3.x/ESXi 3.5 hosts in the same cluster with ESX 4.x/ESXi 4.x hosts. ESX 2.x
hosts cannot be managed by vCenter Server 4.1.

vCenter Server Upgrade Summary
The upgrade to vCenter Server impacts other software components of your datacenter.

Table 3-1 summarizes the impact on your datacenter components.

Table 3-1.  Upgrading vCenter Server Components

Product Component Description

vCenter Server VI Client 1.x Not supported

VirtualCenter Server 1.x Not supported

vSphere Client 4.0 Upgrade
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Table 3-1.  Upgrading vCenter Server Components (Continued)

Product Component Description

NOTE   See the release
notes of the specific
vCenter Server
release to which you
are upgrading for
details on supported
upgrade paths.

VirtualCenter Server 2.0 Not supported

VirtualCenter Server 2.5 Upgrade by using the data migration tool to upgrade to vCenter
Server 4.1 on a different machine.
NOTE   See the release notes of the specific vCenter Server release to
which you are upgrading for details on supported upgrade paths.
Starting with vCenter Server 4.1 Update 1, you cannot upgrade
vCenter Server from releases prior to VirtualCenter Server 2.5
Update 6.

vCenter Server 4.0 Upgrade in place if it is installed on a 64-bit system. If it is installed
on a 32-bit system, upgrade by using the data migration tool to
upgrade to vCenter Server 4.1 on a different machine.
NOTE    See the release notes of the specific vCenter Server release to
which you are upgrading for details on supported upgrade paths.

vCenter Server 4.1 Install

vSphere Client 4.1 Install

Oracle database Verify that your database is supported. Upgrade if necessary.
Oracle 9i is no longer supported.

SQL database Verify that your database is supported. Upgrade if necessary.
Microsoft SQL Server 2000 is no longer supported.

Linked Mode Cannot join a Linked Mode group during the upgrade procedure.
Join after the upgrade to vCenter Server is complete.

License server License server To manage ESX 3.x/ESXi 3.5 hosts, verify that the vCenter Server
system is configured to use a license server. Install a license server
if necessary.

ESX ESX 2.5 host Not supported with vCenter Server 4.1. Supported with vCenter
Server 4.0, but cannot add the hosts to clusters.

VMFS2 volumes Supported as read-only (deprecated)

VM2 virtual machines Upgrade (optional)

VMDK2 virtual disk Not supported with vCenter Server 4.0

ESX MUI No change

VMware Tools Upgrade (optional)

ESX/ESXi 3.5 host Upgrade to ESX/ESXi 4.1 (optional)

ESX/ESXi 4.0 host Upgrade to ESX/ESXi 4.1 (optional)

ESX/ESXi 4.1 Install

VMFS3 volumes No change

VM3 virtual machines Upgrade to VM4 or VM7 (optional)

VMDK3 virtual disk Not supported with vCenter Server 4.1
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Prerequisites for the vCenter Server Upgrade
Before you begin the upgrade to vCenter Server, make sure you have the vCenter Server system and the
database are properly prepared.

vCenter Server Prerequisites
The following items are prerequisites for completing the upgrade to vCenter Server:

n VMware vCenter Server 4.1 installation media.

n License keys for all purchased functionality.

If you do not currently have the license key, you can install in evaluation mode and use the vSphere Client
to enter the license key later.

n The installation path of the previous version of vCenter Server must be compatible with the installation
requirements for Microsoft Active Directory Application Mode (ADAM/AD LDS). For example the
installation path cannot have commas (,) or periods (.). If your previous version of vCenter Server does
not meet this requirement, you must perform a clean installation of vCenter Server 4.1.

n Make sure the system on which you are installing vCenter Server is not an Active Directory domain
controller, primary or backup.

n Either remove any ESX Server 2.x hosts from the VirtualCenter or vCenter Server inventory or upgrade
these hosts.

n Make sure that the computer name has no more than 15 characters.

n vCenter Server 4.1 uses TCP/IP Ports 80 and 443 for the VMware vSphere Web client. You cannot run
vCenter Server on the same machine as a Web server using TCP/IP port 80 (HTTP) or port 443 (HTTPS)
because doing so causes port conflicts.

n Run the vCenter Agent Preupgrade Check tool.

n If the vCenter Server 4.0 environment you are upgrading includes Guided Consolidation 4.0, you must
uninstall Guided Consolidation before upgrading to vCenter Server 4.1.

n If you use vCenter Guided Consolidation Service in the VirtualCenter 2.x environment, complete the
consolidation plan before you upgrade to vCenter Server 4.1. The upgrade to vCenter Server 4.1 does not
preserve or migrate any data gathered by the vCenter Guided Consolidation Service. After the upgrade,
all of the data is cleared, and you cannot restore it.

n Back up the SSL certificates that are on the VirtualCenter or vCenter Server system before you upgrade
to vCenter Server 4.1. The default location of the SSL certificates is installation location\VMware\VMware
VirtualCenter\SSL.

n If you upgrade to vCenter Server on Windows Server 2003 SP1, the disk for the installation directory must
have the NTFS format, not the FAT32 format.

n If you use DHCP instead of a static IP address for vCenter Server, make sure that the vCenter Server
computer name is updated in the domain name service (DNS). One way to test this is by pinging the
computer name. For example, if the computer name is host-1.company.com, run the following command
in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.
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Database Prerequisites
Before you upgrade to vCenter Server, consider the following points:

n If your database server is not supported by vCenter Server, perform a database upgrade to a supported
version or import your database into a supported version. See “Database Scenarios,” on page 31.

n You must perform a complete backup of the VirtualCenter Server or vCenter Server database before you
begin the upgrade. The VirtualCenter 2.5 database schema is not compatible with vCenter Server 4.1. The
vCenter Server 4.1 installer upgrades your existing VirtualCenter Server database schema with extra fields,
thus making the database unusable by VirtualCenter 2.5.

n You must have login credentials, the database name, and the database server name that will be used by
the vCenter Server database. The database server name is typically the ODBC System data store name
(DSN) connection name for the vCenter Server database.

n To use a newly supported IBM DB2 database, you must use vCenter Server 4.0 Update 1 or higher. Previous
releases of VirtualCenter do not support DB2 databases.

n To use a newly supported Oracle database, such as Oracle 11g, you do not need to perform a clean
installation of vCenter Server if your existing database is also Oracle. For example, you can first upgrade
your existing Oracle 9i database to Oracle 10g or Oracle 11g and then upgrade vCenter Server 4.0 to
vCenter Server 4.1.

n To use an Oracle database, the JDBC driver file must be included in the CLASSPATH variable.

n To use a newly supported SQL database, such as Microsoft SQL 2008, you do not need to perform a clean
installation of vCenter Server if your existing database is also Microsoft SQL Server. For example, you can
upgrade a Microsoft SQL Server 2000 database to Microsoft SQL Server 2005 or Microsoft SQL Server 2008
and then upgrade VirtualCenter 2.5 or higher to vCenter Server 4.1.

n To use a Microsoft SQL database, JDK 1.6 must be installed on the vCenter Server machine. In addition,
sqljdbc4.jar must be added to the CLASSPATH variable on the machine where vCenter Server is to be
upgraded.

n If you are upgrading from VirtualCenter 2.5 with the bundled SQL Server 2005 Express (by installing
vCenter Server 4.1 on a different machine and keeping the database), you do not need to perform a clean
installation of vCenter Server.

n If you have a Microsoft SQL database, your system DSN must be using the SQL Native Client driver.

n Make sure that the database user has the following permissions:

n Oracle Either assign the DBA role or grant the following permissions to the
user:

grant connect to <user>

grant resource to <user>

grant create view to <user>

grant create any sequence to <user>

grant create any table to <user>

grant create materialized view to <user>

grant execute on dbms_job to <user>

grant execute on dbms_lock to <user>

grant unlimited tablespace to <user> # To ensure sufficient 

space

After the upgrade is complete, you can optionally remove the following
permissions from the user profile: create any sequence and create any
table.
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By default, the RESOURCE role has the CREATE PROCEDURE,
CREATE TABLE, and CREATE SEQUENCE privileges assigned. If the
RESOURCE role does not have these privileges, grant them to the
vCenter Server database user.

n Microsoft SQL Server Make sure that the database login has the db_owner fixed database role
on the vCenter Server database and on the MSDB database. The
db_owner role on the MSDB database is required for installation and
upgrade only. You can revoke this role after the installation or upgrade
process is complete.

n Also review “Database Scenarios,” on page 31.

vCenter Server Database Patch and Configuration Requirements
After you choose a database type, make sure you understand the configuration and patch requirements for
the database.

NOTE   vCenter Update Manager also requires a database. VMware recommends that you use separate
databases for vCenter Server and vCenter Update Manager.

vCenter Server databases require a UTF codeset.

If your VirtualCenter 2.5 database is not supported for upgrade to vCenter Server 4.1, first upgrade your
database (or import your database into a database that is supported for upgrade to vCenter Server) and then
upgrade to vCenter Server.

Table 3-2 lists the configuration and patch requirements for the databases that are supported for upgrade to
vCenter Server. If your database is not listed in this table, see “Database Scenarios,” on page 31.

Table 3-2 lists the configuration and patch requirements for the databases that are supported with
vCenter Server.

Contact your DBA for the appropriate database credentials.

Table 3-2 lists the configuration and patch requirements for the databases that are supported for upgrade to
vCenter Server.

Table 3-2 lists the configuration and patch requirements for the databases that are supported for upgrade to
vCenter Server. If your database is not listed in this table, see the Upgrade Guide.

For a complete list of database versions supported with vCenter Server, see the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site.
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Table 3-2.  Configuration and Patch Requirements

Database Type Patch and Configuration Requirements

IBM DB2 9.5 If the database is not local to the vCenter Server system, install the IBM Data Server Runtime
Client.
Install the IBM DB2 native client according to the IBM instructions for your DB2 version.
If you are not running DB2 with DB2 9.5 fix pack 5, install Hotfix 22318 for DB2 9.5.0 on the
system where you are installing vCenter Server.
Ensure that C:\Program Files\IBM\SQLLIB\BIN is in the system path. DB2 might be
installed at a different location.
You might need to restart the Microsoft Windows machine for the service to recognize the
change in the environment variable.
Ensure that the machine has a valid ODBC data source name (DSN) entry.

Microsoft SQL Server 2005
Express

Bundled database that you can use for small deployments of up to 5  hosts and 50  virtual
machines.
If the machine has Microsoft SQL Native Client installed, remove it before installing
vCenter Server with the bundled database.
You cannot install the bundled database during an upgrade to vCenter Server. If you want to
use the bundled database, Microsoft SQL Server 2005 Express must be already installed or
you must perform a clean installation of vCenter Server.

Microsoft SQL Server 2005 Ensure that the machine has a valid ODBC DSN entry.
If Microsoft SQL Server 2005 is not already installed and the machine has MSXML Core
Services 6.0 installed, remove MSXML Core Services 6.0 before installing Microsoft SQL Server
2005. If you cannot remove it using the Add or Remove Programs utility, use the Windows
Installer CleanUp utility. See http://support.microsoft.com/kb/968749.

Microsoft SQL Server 2008 Ensure that the machine has a valid ODBC DSN entry.

Oracle 10g If necessary, first apply patch 10.2.0.4 (or later) to the client and server. Then apply patch
5699495 to the client.
Ensure that the machine has a valid ODBC DSN entry.
For the Oracle Instant client, copy ojdbc14.jar to the vCenter Server tomcat directory
(<vCenter install location>\Infrastructure\tomcat\lib)
The Oracle 10g client comes with ojdbc14.jar (<Oracle client install
location>\oracle\product\10.2.0\<instance_name>\jdbc\lib). The vCenter Server
installer copies the file from the Oracle client install location to the vCenter Server tomcat
directory (<vCenter install location>\Infrastructure\tomcat\lib)
If the ojdbc14.jar file is not found in the Oracle 10g client location, the vCenter Server installer
prompts you to copy the file manually. You can download the file from 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html.

Oracle 11g Ensure that the machine has a valid ODBC DSN entry.
For the Oracle Instant client, copy ojdbc14.jar to the vCenter Server tomcat directory
(<vCenter install location>\Infrastructure\tomcat\lib)
The Oracle 11g client comes with ojdbc14.jar (<Oracle client install
location>\app\Administrator\product\11.1.0\<instancename>\sqldeveloper\jd
bc\lib). The vCenter Server installer copies the file from the Oracle client install location to
the vCenter Server tomcat directory (<vCenter install
location>\Infrastructure\tomcat\lib)
If the ojdbc14.jar file is not found in the Oracle 11g client location, the vCenter Server installer
prompts you to copy the file manually. You can download the file from 
http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/htdocs/jdbc101040.html.
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Database Scenarios
When you upgrade to vCenter Server 4.1, make sure that the upgraded version supports your database.

Table 3-3 lists the database types that you can use with VirtualCenter 2.5 and with vCenter Server. This is not
a list of supported database versions. For a list of supported database versions, see the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site. The purpose of Table 3-3 is to describe the
vCenter Server upgrade scenarios for each database type.

Table 3-3.  vCenter Server Upgrade Scenarios for Each Database Type

Database Type

Supported in
VirtualCenter
2.x

Supported
in vCenter
Server 4.0

Supported
in vCenter
Server 4.0
Update 1

Supported in
vCenter Server
4.1 Update 1 Supported Scenario

IBM DB2 No No Yes Yes You can install or upgrade to
vCenter Server 4.1 from
vCenter Server 4.0 Update 1.
You cannot upgrade from
vCenter Server 4.0 because
vCenter Server 4.0 Update 1 is the
first release that supports
IBM DB2 database servers.

Experimental
MSDE database

Yes
(VirtualCenter
2.0.x)

No No No After you upgrade to a database
server that is supported by
vCenter Server, you can install or
upgrade to vCenter Server.

Microsoft SQL
Server 2000

Yes No No No After you upgrade to a database
server that is supported by
vCenter Server, you can install or
upgrade to vCenter Server.

Microsoft SQL
Server 2005
Express

Yes Yes Yes Yes You can install or upgrade to
vCenter Server.

Microsoft SQL
Server 2005

Yes Yes Yes Yes You can install or upgrade to
vCenter Server.

Microsoft SQL
Server 2008
Express

No No No Yes You can install or upgrade to
vCenter Server.

Microsoft SQL
Server 2008

No Yes Yes Yes You can install or upgrade to
vCenter Server.

Oracle 9i Yes No No No After you upgrade to a database
server that is supported by
vCenter Server, you can install or
upgrade to vCenter Server.

Oracle 10g Yes Yes Yes Yes You can install or upgrade to
vCenter Server.

Oracle 11g No Yes Yes Yes You can install or upgrade to
vCenter Server.

If you perform a fresh installation of vCenter Server 4.1, you can then import your database information into
a database that is supported by vCenter Server 4.1. For information about performing a fresh installation, see
the ESX and vCenter Server Installation Guide or the ESXi and vCenter Server Setup Guide. For information about
importing your database, see Chapter 5, “Upgrade to vCenter Server on a Different Machine and Upgrade the
Existing Database,” on page 39.
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Configure vCenter Server to Communicate with the Local Database
After Shortening the Computer Name to 15 Characters or Fewer

The machine on which you install or upgrade to vCenter Server must have a computer name that is 15
characters or fewer. If your database is located on the same machine on which vCenter Server will be installed,
and you have recently changed the name of this machine to comply with the name-length requirement, make
sure the vCenter Server DSN is configured to communicate with the new name of the machine.

Changing the vCenter Server computer name impacts database communication if the database server is on the
same computer with vCenter Server. If you have changed the machine name, verify that communication
remains intact by completing the following procedure.

The name change has no impact on communication with remote databases. You can skip this procedure if your
database is remote.

NOTE   The name-length limitation applies to the vCenter Server system. The data source name (DSN) and
remote database systems can have names with more than 15 characters.

Check with your database administrator or the database vendor to make sure all components of the database
are working after you rename the server.

Prerequisites

n Make sure the database server is running.

n Make sure that the vCenter Server computer name is updated in the domain name service (DNS).

One way to test this is by pinging the computer name. For example, if the computer name is
host-1.company.com, run the following command in the Windows command prompt:

ping host-1.company.com

If you can ping the computer name, the name is updated in DNS.

Procedure

1 Update the data source information, as needed.

2 Verify the data source connectivity.

Back Up VirtualCenter 2.5 or Higher
You must back up a VirtualCenter 2.x system to ensure that you can restore your previous configuration of
VirtualCenter if the vCenter Server upgrade does not complete successfully. The only way to recover from an
unsuccessful upgrade is to use your backed up database and SSL certificates.

IMPORTANT   If you begin the upgrade to vCenter Server, and you did not back up the VirtualCenter 2.5 or higher
database and SSL certificates, you cannot restore your previous VirtualCenter configuration. You cannot roll
back your database to the previous database schema.

Procedure

1 Make a full backup of the VirtualCenter 2.5 or higher database.

See your database documentation.
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2 Back up the VirtualCenter 2.5 or higher SSL certificates.

a Copy the SSL certificate folder under %ALLUSERSPROFILE%\Application Data\VMware\VMware
VirtualCenter or %ALLUSERSPROFILE%\VMware\VMware VirtualCenter\.

b Paste it at the backup location.

3 Take notes on the existing VirtualCenter installation regarding the selections, settings, and information
used.

For example, note any nondefault settings, such as the IP address, the database DSN, user name, password,
and assigned ports.

4 Create a backup copy of vpxd.cfg.

What to do next

Continue with the upgrade to vCenter Server.

Run the vCenter Agent Preupgrade Check Tool
The vCenter Agent Preupgrade Check tool is a diagnostic read-only tool that produces a report showing known
issues that might prevent a successful upgrade of the vCenter Agent software. To help ensure a successful
upgrade to vCenter Server 4.1, you must diagnose and fix any potential problems on the managed ESX/ESXi
hosts. You can run the vCenter Agent Preupgrade Check tool for in-place upgrades from vCenter Server 4.0
to vCenter Server 4.1.

vCenter Agent runs on all managed ESX/ESXi hosts. This software coordinates actions received from vCenter
Server. When you add a host to vCenter Server, the agent is installed on the physical ESX/ESXi host. When
you upgrade to vCenter Server 4.1, the agent residing on each ESX/ESXi host must be upgraded as well.

During a vCenter Server upgrade, the existing agent software is uninstalled and the updated agent software
is installed in its place. If the upgrade fails, the updated agent software might not be installed and the host
might become unreachable by VirtualCenter 2.x, vCenter Server 4.0, and by vCenter Server 4.1. To avoid this
condition, you can run the vCenter Agent Preupgrade Check tool before you attempt to upgrade to vCenter
Server 4.1.

The vCenter Agent Preupgrade Check tool checks to make sure that the agent software is ready to be upgraded.
Some of the checks include checking to make sure that the host is reachable, the disk space is sufficient, the
network is functioning, the file system is intact, and required patches are applied. Each time you run the tool,
the system queries VMware.com and downloads any new updates for the tool. This action ensures that as new
upgrade issues are discovered, the tool remains as useful as possible.

IMPORTANT   A successful vCenter Agent preupgrade check does not guarantee a successful upgrade to
vCenter Server 4.1. An upgrade to vCenter Server involves multiple components, and the tool checks only one
component: the vCenter Agent. Also, the tool checks only known issues. Other issues might be present that
the tool does not check.

The vCenter Agent Preupgrade Check tool does not fix the reported issues. You must resolve the reported
issues manually and rerun the tool to verify that the issues are resolved.

Prerequisites

n VirtualCenter 2.x or later must be installed on a Windows machine that is supported by vCenter Server
4.1.

n The VirtualCenter 2.x or later machine must have a DSN configured that is compatible with vCenter Server
4.1.
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n The VirtualCenter 2.x database must be supported by vCenter Server 4.1. This means that, if needed, the
database must be upgraded to work with vCenter Server 4.1. The MSDE database was supported in
experimental mode in VirtualCenter Server 2.0.x, but is not supported in vCenter Server 4.1. The vCenter
Agent Preupgrade Check tool will not detect the database. Upgrade to a supported database before using
the tool. See “Database Scenarios,” on page 31.

n The ESX/ESXi hosts must be managed by VirtualCenter 2.x or later.

n VirtualCenter Agent or vCenter Agent software must be running on each managed ESX/ESXi host.

n Microsoft .NET Framework Version 2.0 must be installed on the VirtualCenter 2.x or later system.

n VMware recommends that you have Internet connectivity from the VirtualCenter 2.x or later system. This
allows new updates to be applied to the tool and allows you to view the reports and the Knowledge Base
(KB) articles associated with the reports.

Procedure

1 On the VirtualCenter 2.x or later system you are updating from, download the vCenter Server 4.1
installation package or insert the vCenter Server 4.1 installation DVD.

2 Start the Preupgrade Check tool.

n In the installation package or on the DVD, navigate to \vpx\agentupgradecheck and run the
AgentUpgradeChecker.exe executable file.

n Start the installation process from the DVD and when asked to select an item to install, select the
Agent Pre-upgrade Check option from the Utility list.

3 Select the DSN for the VirtualCenter or vCenter Server system you are upgrading from and select the login
credentials that are appropriate for that DSN.

If you are not sure which credential type to select, check which authentication type is configured for the
DSN (Control Panel > Administrative Tools > ODBC Data Sources > System DSN).

4 If the DSN requires a login for the credential type in use, enter a user name and password and click
Next.

5 Select an option for scanning all hosts or specific hosts.

Option Action

Scan all of the hosts Select Standard Mode and click Next.

Specify hosts to scan a Select Custom Mode and click Next.
b Select the hosts to scan and click Next. To select all hosts in a cluster,

double-click the cluster.
 

6 Click Run Precheck.

The tool takes 30-40 seconds for each host.

7 When the check is complete, click Next.

8 View the pre-upgrade reports.

n To view the report for an individual host, click the link next to the host name.

n To view a summary report for all hosts, click View Report.

You now have a list of issues to resolve before you upgrade to vCenter Server 4.1.

What to do next

From the report, use the linked KB articles to research and resolve the issues on each host. After you resolve
the issues, rerun the vCenter Agent Preupgrade Check tool. Repeat this process until you resolve all the
reported issues, and then proceed with your upgrade to vCenter Server 4.1.
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Downtime During the vCenter Server Upgrade
When you upgrade to vCenter Server, no downtime is required for the ESX/ESXi hosts that vCenter Server is
managing. Nor is downtime required for the virtual machines that are running on the hosts. Downtime is
required for vCenter Server.

Expect downtime for vCenter Server as follows:

n VMware estimates that the upgrade requires vCenter Server to be out of production for 25-30 minutes,
depending on the size of the database. The database schema upgrade takes approximately 8 minutes of
this time. This estimate does not include host reconnection after the upgrade.

If the machine does not have Microsoft .NET Framework installed, a reboot will be required after the
upgrade to vCenter Server.

n VMware Distributed Resource Scheduler does not work while the upgrade is in progress. VMware HA
does work during the upgrade.

Chapter 3 Preparing for the Upgrade to vCenter Server
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Upgrading to vCenter Server 4.1 4
The upgrade to vCenter Server includes a database schema upgrade and an upgrade of vCenter Server 4.0 or
higher.

Upgrade to vCenter Server 4.1
Upgrade vCenter Server 4.0 to vCenter Server 4.1 on the same machine if the vCenter Server 4.0 instance is on
a 64-bit machine.

This procedure requires downtime for the vCenter Server that you are upgrading. You do not need to power
off virtual machines.

The vCenter Server installer detects earlier versions of vCenter Server and upgrades it.

If the upgrade fails, no automatic rollback occurs to the previous vCenter Server version.

Prerequisites

See “Prerequisites for the vCenter Server Upgrade,” on page 27 for requirements for the vCenter Server system
and requirements for the database.

Close all instances of the VI Client and the vSphere Client.

Procedure

1 As Administrator on the Windows system, insert the VMware vCenter Server Installation DVD or double-
click autorun.exe.

2 On the vCenter Server Installer page, click vCenter Server.

3 Select a language for the installer and click OK.

The Welcome page informs you that an earlier version of vCenter Server is on the computer and will be
upgraded to vCenter Server 4.1.

4 Click Next.

5 Review the End-User Patent Agreement and click Next.

6 Select I agree to the terms in the license agreement and click Next.

7 Select the DSN and click Next..

The DSN must be a 64-bit DSN. Depending on the database type, the DSN might already be selected, or
there might be only one option.
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8 Enter the database password that corresponds to the user name and DSN that the installer displays and
click Next.

If you specify a remote SQL Server database that uses Windows NT authentication, the database user and
the logged-in user on the vCenter Server machine must be the same.

9 Select whether to upgrade the vCenter Server database schema.

n Select Yes, I want to upgrade my vCenter Server database to continue with the upgrade to
vCenter Server.

n Select No, I do not want to upgrade my vCenter Server database if you do not have a backup copy
of your database.

If you choose this option, you cannot continue the upgrade. Cancel the upgrade, back up your
VirtualCenter or vCenter Server environment, and restart the upgrade process.

10 Click I have taken a backup of the existing vCenter Server database and SSL certificates and click
Next.

11 Select how to upgrade vCenter Agent and click Next.

Option Description

Automatic vCenter Agent is upgraded on all hosts in the vCenter Server inventory.

Manual All hosts are disconnected from vCenter Server. To upgrade vCenter Agent,
reconnect the host to vCenter Server.
Select this option if one of the following applies:
n You need to control the timing of vCenter Agent upgrades on specific

hosts.
n The number of hosts in the vCenter Server inventory is large, and you

anticipate that upgrading vCenter Agent on all hosts would negatively
affect vCenter Server performance.

 
vCenter Agent is installed on each host in the inventory to enable vCenter Server to manage the host.
vCenter Agent must be upgraded when vCenter Server is upgraded.

12 Specify the account for the vCenter Service to run in.

n Click Next to use the SYSTEM account. You cannot use the SYSTEM account if you are using Windows
authentication for SQL Server.

n Deselect Use SYSTEM Account and enter a different Administrator account name and password.

13 Enter the port numbers to use or accept the default port numbers shown on the page and click Next.

14 Select the amount of memory to allocate to the vCenter JVM in Tomcat, according to the number of hosts
in your environment.

You can adjust this setting after installation if the number of hosts in your environment changes.

15 Click Install.

What to do next

See Chapter 6, “Postupgrade Considerations for vCenter Server,” on page 51.
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Upgrade to vCenter Server on a
Different Machine and Upgrade the
Existing Database 5

When you upgrade to vCenter Server, you can migrate vCenter Server to a new machine. One reason for doing
this is to move from a 32-bit machine to a 64-bit machine.

You can also use the data migration tool to migrate a SQL Server Express database installed by the vCenter
Server installer on the same machine as vCenter Server. If you use a different database installed on the vCenter
Server machine, you must back up and move the database manually to the new machine. If the database is
installed on a different machine from vCenter Server, you can leave the database in place and create a new
DSN on the destination machine to connect to it.

The VirtualCenter or vCenter Server configuration settings that you can migrate with the tool include:
n LDAP data

n Port settings for the HTTP, HTTPS, heartbeat, Web services, LDAP, and LDAP SSL ports

n Certificates stored in the SSL folder

n License

n Database data for a bundled SQL Server Express database only

If VMware vCenter Update Manager or vCenter Orchestrator is installed on the same machine as vCenter
Server, you can use the data migration tool to migrate configuration data for these products. You can also use
the tool to migrate the vCenter Update Manager database if it is a SQL Server Express database installed on
the same machine as vCenter Update Manager and vCenter Server. You cannot use the data migration tool to
migrate the vCenter Orchestrator database. See the documentation for vCenter Update Manager and vCenter
Orchestrator for more information on upgrading these products.

Prerequisites

If you are using a remote database, either remove any ESX Server 2.x hosts from the VirtualCenter or vCenter
Server inventory or upgrade these hosts. If you are not using a remote database, you do not need to remove
ESX Server 2.x hosts from the VirtualCenter or vCenter Server inventory or upgrade them, however they will
not be connected to the vCenter Server after the upgrade.

Stop the VMware VirtualCenter Server service before performing this upgrade.

Procedure

1 Back Up and Move the vCenter Server Database on page 40
Before you upgrade vCenter Server, back up the vCenter Server database. If you are migrating vCenter
Server to a new machine, you have several options for moving the database.

VMware, Inc.  39



2 Back Up VirtualCenter or vCenter Server Configuration with the Data Migration Tool on page 43
Use the data migration tool to back up VirtualCenter or vCenter Server configuration data such as port
settings, SSL certificates, and licensing information. The data migration tool can restore these settings
when you upgrade to vCenter Server on a new 64-bit machine.

3 Create a 64-Bit DSN on page 44
The vCenter Server system must have a 64-bit DSN. This requirement applies to all supported databases.
By default, any DSN created on a 64-bit system is 64 bit.

4 Restore the vCenter Server Configuration and Install vCenter Server on the Destination Machine on
page 45
Use the data migration tool to start the vCenter Server installer and restore the vCenter Server
configuration to the destination machine.

5 Update the vCenter Server Name for Plug-Ins on page 49
When you migrate the vCenter Server configuration to a destination machine that does not have the same
name as the source machine, you must update the plug-ins to use the new machine name. Plug-ins
registered to the vCenter Server system cannot access the destination vCenter Server machine until this
update is complete.

6 Migrate a License Server Installed on the Same Machine as vCenter Server on page 49
If the license server was installed with vCenter Server on the source machine, the data migration tool
cannot migrate the license server to the destination machine. You must migrate the license configuration
manually.

Back Up and Move the vCenter Server Database
Before you upgrade vCenter Server, back up the vCenter Server database. If you are migrating vCenter Server
to a new machine, you have several options for moving the database.

Procedure

n If your database is remote from VirtualCenter or vCenter Server, and you want it to remain remote after
the upgrade, leave the database where it is after you back it up.

n If your database is local to VirtualCenter or vCenter Server, and you want it to remain local after the
upgrade, you have the following options depending on the type of database.

Option Description

Microsoft SQL Server Express
database

If the database was installed by the vCenter Server installer, back up the
database, and move the database along with other configuration data using
the data migration tool. A separate database migration step is not necessary.
If the SQL Server Express database was not installed by the vCenter Server
installer, back up the database and restore it onto the machine on which you
are installing vCenter Server.

Microsoft SQL Server database Do one of the following:
n Back up the database, detach the database, and attach it to the machine

to which you are installing vCenter Server.
n Back up the database, and restore it onto the machine on which you are

installing vCenter Server.

Other local databases Back up the database, and restore it onto the machine on which you are
installing vCenter Server.

 
For Microsoft SQL Server databases, when you decide between the backup/restore option or the
detach/attach option, consider the downtime required. For guidance on these options, consult your
organization's database administrator.
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What to do next

Back up the VirtualCenter or vCenter Server configuration using the data migration tool.

Back Up and Restore a Microsoft SQL Database
Before you perform an upgrade to vCenter Server on a new machine, you might want to move the database.
For example, if your database currently resides on the same machine as vCenter Server, you might want to
move it to the same machine to which you will move vCenter Server.

Moving the database is optional. To move a Microsoft SQL Server database, you can perform a backup and
restore operation.

Consult your database administrator or see your database documentation about backing up and restoring
databases.

The machine with the VirtualCenter 2.5 or vCenter Server 4.0 database is called the source machine. The
machine on which the vCenter Server 4.1 database will reside is called the destination machine.

Prerequisites

n Verify that you have a VirtualCenter 2.5 or vCenter Server 4.0 system running with a local or remote
Microsoft SQL Server database.

n Verify that Microsoft SQL Server and Microsoft SQL Server Management Studio are installed on the source
machine and the destination machine.

Procedure

1 On the source machine, stop the VirtualCenter service.

a Select Start > Programs > Administrative Tools > Services.

b Right-click VMware VirtualCenter Server and select Stop.

2 In SQL Server Management Studio, make a full back up of the source machine database.

3 Copy the backup file (.bak) to the C:\ drive on the destination machine.

4 On the destination machine, open SQL Server Management Studio and right-click the Databases folder.

5 Select New Database, enter the source machine database name, and click OK.

6 Right-click the new database icon and select Task > Restore > Database.

7 Select From Device and click Browse.

8 Click Add, navigate to the backup file, and click OK.

9 In the Restore Database window, select the check box next to the .bak file.

10 On the Options page, select the Overwrite the existing database check box and click OK.

The original database is restored onto the new database, which you can use for the upgrade to vCenter
Server 4.1.

What to do next

See “Back Up VirtualCenter or vCenter Server Configuration with the Data Migration Tool,” on page 43.

Chapter 5 Upgrade to vCenter Server on a Different Machine and Upgrade the Existing Database
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Detach and Attach a Microsoft SQL Server Database
Before you perform an upgrade to vCenter Server on a 64-bit machine, you can optionally detach the
VirtualCenter or vCenter Server database on the source machine, copy the files to the destination machine,
and attach the database on the destination machine. This detach-and-attach action is an alternative to the
backup and restore operation.

Consult your database administrator or see your database documentation about detaching and attaching
databases.

The machine with the VirtualCenter 2.5 or vCenter Server 4.0 database is called the source machine. The
machine on which the vCenter Server 4.1 database will reside is called the destination machine.

Prerequisites

n Make a full backup of the database.

n Verify that you have a VirtualCenter 2.5 or vCenter Server 4.0 system running with a local or remote
Microsoft SQL Server database.

n Verify that Microsoft SQL Server and Microsoft SQL Server Management Studio are installed on the source
machine and the destination machine.

Procedure

1 On the source machine, stop the VirtualCenter service.

a Select Start > Control Panel > Administrative Tools > Services.

b Right-click VMware VirtualCenter Server and select Stop.

2 In the SQL Server Management Studio, open the Databases directory.

3 Right-click the source database and select Tasks > Detach.

4 Select the database and click OK.

5 When the detach operation is complete, copy the data files (.mdf and .ldf) to the destination machine's
database folder.

By default, the database folder is C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data.

6 In SQL Server Management Studio on the destination machine, right-click the Databases directory and
select Attach.

7 Select the .mdf file that you copied to the destination machine's database folder and click OK.

The database from the source machine is attached to the destination machine.

What to do next

See “Back Up VirtualCenter or vCenter Server Configuration with the Data Migration Tool,” on page 43.

Back Up and Restore an Oracle Database
Before you perform an upgrade to vCenter Server on a different machine, you might want to move the database.
Moving the database is optional. To move an Oracle database, you perform a backup and restore operation.

Consult your database administrator or see your database documentation about backing up and restoring
databases.

The machine with the VirtualCenter 2.5 or vCenter Server 4.0 database is called the source machine. The
machine on which the vCenter Server 4.1 database will reside is called the destination machine.
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Prerequisites

Verify that you have a VirtualCenter 2.5 or vCenter Server 4.0 system running with a local or remote Oracle 10g
or Oracle 11g database.

Procedure

1 On the source machine, stop the VirtualCenter service.

a Select Start > Programs > Administrative Tools > Services.

b Right-click VMware VirtualCenter Server and select Stop.

2 On the source machine, log in to Oracle SQL*Plus as the VirtualCenter 2.5 or vCenter Server 4.0 database
user.

3 Export the database as a .dmp file.

4 Copy the .dmp file onto the C:\ drive of the destination machine.

5 In Oracle SQL*Plus, run the following command to create the tablespace.

create tablespace vctest datafile 'c:\vctest.dbf' size 100m autoextend on;

6 Run the following command to create a user. 

create user VCUSER identified by CENSORED default tablespace vctest;

7 Import the .dmp file into the Oracle 64-bit database on the destination machine.

8 Verify that all the table data is imported.

The original database is restored onto the new database, which you can use for the upgrade to
vCenter Server 4.1.

What to do next

See “Back Up VirtualCenter or vCenter Server Configuration with the Data Migration Tool,” on page 43.

Back Up VirtualCenter or vCenter Server Configuration with the Data
Migration Tool

Use the data migration tool to back up VirtualCenter or vCenter Server configuration data such as port settings,
SSL certificates, and licensing information. The data migration tool can restore these settings when you upgrade
to vCenter Server on a new 64-bit machine.

If your database is a SQL Server Express database that is local to the VirtualCenter or vCenter Server machine,
the data migration tool will back up the database and restore it to the destination machine.

If VMware vCenter Orchestrator is installed on the same machine as VirtualCenter or vCenter Server, the data
migration tool will back up the vCenter Orchestrator configuration and restore it to the destination machine.
The data migration tool does not back up and restore the vCenter Orchestrator database. See the VMware
vCenter Orchestrator documentation for information about upgrading vCenter Orchestrator using the data
migration tool.

If VMware vCenter Update Manager is installed on the same machine as VirtualCenter or vCenter Server, the
data migration tool will back up the vCenter Update Manager configuration and restore it to the destination
machine. If vCenter Update Manager uses a SQL Server Express database that is local to the source machine,
the data migration tool will back up the database and restore it to the destination machine. The data migration
tool does not back up and restore patch binaries. See the VMware vCenter Update Manager documentation
for information about upgrading vCenter Update Manager with the data migration tool.

Chapter 5 Upgrade to vCenter Server on a Different Machine and Upgrade the Existing Database
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Prerequisites

n Verify that a supported version of VirtualCenter or vCenter Server is installed on the source machine:

n VirtualCenter 2.5 and its update releases

n vCenter Server 4.0 and its update releases

n Stop the VMware VirtualCenter Server service before backing up the configuration.

n If the \datamigration\data\ folder already exists from a previous backup attempt, backup cannot proceed.
Remove or rename this folder before backing up the vCenter Server configuration.

Procedure

1 As Administrator on the Windows system, insert the VMware vCenter Server Installation DVD or double-
click autorun.exe.

2 Click Explore media.

3 Open the datamigration folder and extract the datamigration.zip archive to a writeable local file system
on the source VirtualCenter or vCenter Server machine.

4 From the Windows command prompt, change to the datamigration folder and type backup.bat to run the
backup script of the data migration tool.

5 Respond to the script prompts.

The script checks the vCenter Server version, database type, vCenter Update Manager configuration (if
installed), and vCenter Orchestrator configuration (if installed) to determine whether they are compatible
with the data migration tool.

6 If VMware vCenter Update Manager is not installed, enter y when prompted to continue the backup.

The VirtualCenter or vCenter Server configuration data and the SQL Server Express database (if
applicable) are copied to the \data folder in the extracted folder. The VirtualCenter or vCenter Server
database instance is upgraded to be compatible with vCenter Server 4.1.

7 Check \logs\backup.log in the datamigration folder for errors.

n If you find no errors, the data backup was successful.

n If you find errors, correct the source of the error and rerun backup.bat before proceeding.

What to do next

n If your database is a SQL Server Express database local to the vCenter Server machine, see “Restore the
vCenter Server Configuration and Install vCenter Server on the Destination Machine,” on page 45.

n If you are using another database, see “Create a 64-Bit DSN,” on page 44.

Create a 64-Bit DSN
The vCenter Server system must have a 64-bit DSN. This requirement applies to all supported databases. By
default, any DSN created on a 64-bit system is 64 bit.

If you use the data migration tool to migrate a SQL Server Express database located on the vCenter Server
system to a new system, you do not need to create the 64-bit DSN. The data migration tool creates the DSN as
part of the installation process. For other non-bundled databases, you must create a 64-bit DSN.

Procedure

1 Install the 64-bit database ODBC drivers on your Microsoft Windows system.

The default installation location is C:\Program Files\VMware\Infrastructure\VirtualCenter Server.

2 Click Control Panel > Administrative Tools > Data Sources (ODBC).
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3 Use the application to create a system DSN and test the connectivity.

The system now has a DSN that is compatible with vCenter Server. When the vCenter Server installer prompts
you for a DSN, select the 64-bit DSN.

Restore the vCenter Server Configuration and Install vCenter Server on
the Destination Machine

Use the data migration tool to start the vCenter Server installer and restore the vCenter Server configuration
to the destination machine.

n Restore the vCenter Server Configuration and a Bundled Database and Install vCenter Server on the
Destination Machine on page 45
If you used the data migration tool to back up the vCenter Server configuration and bundled SQL Server
database, use the data migration tool to install vCenter Server and restore the vCenter Server
configuration and database to the destination machine.

n Restore the vCenter Server Configuration and Install vCenter Server on the New Machine with a
Nonbundled Database on page 47
If you used the data migration tool to back up the configuration of a vCenter Server system connected
to a nonbundled database, use the data migration tool to install vCenter Server and restore the vCenter
Server configuration to the destination machine.

Restore the vCenter Server Configuration and a Bundled Database and Install
vCenter Server on the Destination Machine

If you used the data migration tool to back up the vCenter Server configuration and bundled SQL Server
database, use the data migration tool to install vCenter Server and restore the vCenter Server configuration
and database to the destination machine.

Use this procedure if you used the data migration tool to back up a SQL Server Express database local to the
vCenter Server machine. The data migration tool restores the database to the new machine.

VMware recommends using the same host name for the destination machine that you used for the source
machine.

Prerequisites

Ensure that the destination vCenter Server machine has access to all other systems that it must connect to, such
as the domain server, Windows Active Directory server with vCenter user accounts, database server, license
server, and so on.

Procedure

1 Copy the datamigration folder from the source machine to the destination machine.

2 Insert the vCenter Server installation media into the DVD-ROM drive on the new machine, or copy the
installation ISO image to the new machine.

3 From the Windows command prompt, change to the datamigration folder copied from the source machine
and type install.bat.

4 If the name of the new machine is different from the name of the source machine, enter y to continue.

5 Enter the path to the vCenter Server installation media.

For example, if the installation media is in D:\Temp\VMware-VIMSetup-en-4.1.0-build number, enter
D:\Temp\VMware-VIMSetup-en-4.1.0-build number.

The install script verifies that migration data is present, and launches the vCenter Server installer.
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6 Select a language for the installer and click OK.

The Welcome page informs you that an earlier version of vCenter Server is on the computer and will be
upgraded to vCenter Server 4.1.

7 When the Welcome screen appears, click Next.

8 Review the End-User Patent Agreement and click Next.

9 Select I agree to the terms in the license agreement and click Next.

10 Select Install SQL Server 2005 Express instance (for small-scale deployments) and click Next.

11 Enter the password for the vCenter Service user account.

12 Either accept the default destination folders or click Change to select another location, and click Next.

The installation path cannot have commas (,) or periods (.).

NOTE   To install the vCenter Server on a drive other than C:, verify that there is enough space in the
C:\WINDOWS\Installer folder to install the Microsoft Windows Installer .msi file. If you do not have enough
space, your vCenter Server installation might fail.

13 Enter the port numbers to use or accept the port numbers shown and click Next.

The port numbers displayed are those that were backed up from the source VirtualCenter or vCenter
Server installation.

14 Select the amount of memory to allocate to the vCenter JVM in Tomcat, according to the number of hosts
in your environment.

You can adjust this setting after installation if the number of hosts in your environment changes.

15 Click Install.

16 When the vCenter Server installation finishes, click Finish.

The data migration tool restores the backed up configuration data.

17 Check the \logs\restore.log file in the datamigration folder, and verify that no errors occurred during
the restore process.

vCenter Server is installed, and the settings that you backed up are restored. The SQL Server Express database
is also restored on the new machine. After the installation is complete, vCenter Server is started.

If you used the data migration tool to back up VMware vCenter Update Manager configuration data, the
vCenter Update Manager installer is launched. Complete the steps in the installation wizard to install vCenter
Update Manger and restore the configuration. See the VMware vCenter Update Manager documentation for
more information.

If you used the data migration tool to back up VMware vCenter Orchestrator configuration data, the vCenter
Orchestrator installer is launched. Complete the steps in the installation wizard to install vCenter Orchestrator
and restore the configuration. See the VMware vCenter Orchestrator documentation for more information.

What to do next

n If the new vCenter Server machine has a different name than the source machine, update plug-ins and
other solutions that access the vCenter Server system with the name of the new machine. See “Update the
vCenter Server Name for Plug-Ins,” on page 49.

n If a license server was installed on the source machine, install the license server on the destination machine
and migrate the licenses. See “Migrate a License Server Installed on the Same Machine as vCenter
Server,” on page 49.

n See Chapter 6, “Postupgrade Considerations for vCenter Server,” on page 51.
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Restore the vCenter Server Configuration and Install vCenter Server on the New
Machine with a Nonbundled Database

If you used the data migration tool to back up the configuration of a vCenter Server system connected to a
nonbundled database, use the data migration tool to install vCenter Server and restore the vCenter Server
configuration to the destination machine.

Prerequisites

Ensure that the destination vCenter Server machine has access to all other systems that it must connect to, such
as the domain server, Windows Active Directory server with vCenter user accounts, database server, license
server, and so on.

Procedure

1 Copy the datamigration folder from the source machine to the destination machine.

2 Insert the vCenter Server installation media into the DVD-ROM drive on the new machine, or copy the
installation ISO image to the new machine.

3 From the Windows command prompt, change to the datamigration folder copied from the source machine
and type install.bat.

4 If the name of the new machine is different from the name of the source machine, enter y to continue.

5 Enter the path to the vCenter Server installation media.

For example, if the installation media is in D:\Temp\VMware-VIMSetup-en-4.1.0-build number, enter
D:\Temp\VMware-VIMSetup-en-4.1.0-build number.

The install script verifies that migration data is present, and launches the vCenter Server installer.

6 Select a language for the installer and click OK.

The Welcome page informs you that an earlier version of vCenter Server is on the computer and will be
upgraded to vCenter Server 4.1.

7 When the Welcome screen appears, click Next.

8 Review the End-User Patent Agreement and click Next.

9 Select I agree to the terms in the license agreement and click Next.

10 Enter the information for the remote database.

a Click Use an existing supported database.

b Select the DSN that was used for the database on the 32-bit source machine and click Next.

c Enter the user name and password for the DSN and click Next.

If you specify a remote SQL Server database that uses Windows NT authentication, the database user
and the logged-in user on the vCenter Server machine must be the same.

d Select Upgrade existing vCenter Server database and select the I have taken a backup of the existing
vCenter Server database and SSL certificates check box.

e Click Next.
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11 Select how to upgrade vCenter Agent and click Next.

Option Description

Automatic vCenter Agent is upgraded on all hosts in the vCenter Server inventory.

Manual All hosts are disconnected from vCenter Server. To upgrade vCenter Agent,
reconnect the host to vCenter Server.
Select this option if one of the following applies:
n You need to control the timing of vCenter Agent upgrades on specific

hosts.
n The number of hosts in the vCenter Server inventory is large, and you

anticipate that upgrading vCenter Agent on all hosts would negatively
affect vCenter Server performance.

 
vCenter Agent is installed on each host in the inventory to enable vCenter Server to manage the host.
vCenter Agent must be upgraded when vCenter Server is upgraded.

12 Enter the password for the vCenter Service user account.

13 Either accept the default destination folders or click Change to select another location, and click Next.

The installation path cannot have commas (,) or periods (.).

NOTE   To install the vCenter Server on a drive other than C:, verify that there is enough space in the
C:\WINDOWS\Installer folder to install the Microsoft Windows Installer .msi file. If you do not have enough
space, your vCenter Server installation might fail.

14 Enter the port numbers to use or accept the port numbers shown and click Next.

The port numbers displayed are those that were backed up from the source VirtualCenter or vCenter
Server installation.

15 Select the amount of memory to allocate to the vCenter JVM in Tomcat, according to the number of hosts
in your environment.

You can adjust this setting after installation if the number of hosts in your environment changes.

16 Click Install.

17 When the vCenter Server installation finishes, click Finish.

The data migration tool restores the backed up configuration data.

18 Check the \logs\restore.log file in the datamigration folder, and verify that no errors occurred during
the restore process.

vCenter Server is installed, and the settings that you backed up are restored. The remote database is upgraded.
After the installation is complete, vCenter Server is started.

If you used the data migration tool to back up VMware vCenter Update Manager configuration data, the
vCenter Update Manager installer is launched. Complete the steps in the installation wizard to install vCenter
Update Manger and restore the configuration. See the VMware vCenter Update Manager documentation for
more information.

If you used the data migration tool to back up VMware vCenter Orchestrator configuration data, the vCenter
Orchestrator installer is launched. Complete the steps in the installation wizard to install vCenter Orchestrator
and restore the configuration. See the VMware vCenter Orchestrator documentation for more information.

What to do next

n If the new vCenter Server machine has a different name than the source machine, update plug-ins and
other solutions that access the vCenter Server system with the name of the new machine. See “Update the
vCenter Server Name for Plug-Ins,” on page 49.
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n If a license server was installed on the source machine, install the license server on the destination machine
and migrate the licenses. See “Migrate a License Server Installed on the Same Machine as vCenter
Server,” on page 49.

n See Chapter 6, “Postupgrade Considerations for vCenter Server,” on page 51.

Update the vCenter Server Name for Plug-Ins
When you migrate the vCenter Server configuration to a destination machine that does not have the same
name as the source machine, you must update the plug-ins to use the new machine name. Plug-ins registered
to the vCenter Server system cannot access the destination vCenter Server machine until this update is
complete.

Procedure

1 Open the extension.xml file for the plug-in in a text editor.

The extension.xml file is located in the folder for the plug-in in C:\Program
Files\VMware\Infrastructure\VirtualCenter Server\extensions\. For example, the extension.sml file
for the vCenter Storage Monitoring plug-in is C:\Program Files\VMware\Infrastructure\VirtualCenter
Server\extensions\com.vmware.vim.sms\extension.xml.

2 Edit the contents of the <url> tag to replace the name of the source vCenter Server system with the name
of the new vCenter Server system.

For example: If the new server name is vcenter.example.com, the <url> tag might read
<url>http://vcenter.example.com:80/sms/smService-web/health.xml</url>.

3 Save the extension.xml file.

4 Re-register the extension with vCenter Server.

Migrate a License Server Installed on the Same Machine as vCenter
Server

If the license server was installed with vCenter Server on the source machine, the data migration tool cannot
migrate the license server to the destination machine. You must migrate the license configuration manually.

Prerequisites

If you do not have the license server installer, download it from the VMware Web site.

Procedure

1 Install the license server on the destination machine.

2 Copy the license files from the license folder on the source machine to the license folder on the destination
machine.

By default, the license folder is C:\Program Files\VMware\VMware License Server\Licenses\.

3 Reload the licenses.

a Select Start > Programs > VMware > VMware License Server > VMware License Server Tools.

b Click the Start/Stop/Reread tab.

c Select the VMware License Server.

d Click ReRead License File.
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4 Update vCenter Server licensing settings with the license server machine name.

a Connect to the vCenter Server using the vSphere Client.

b Select Administration > vCenter Server Settings.

c Select Licensing.

d In the License Server text box, enter the port number and license server machine name as port@host.

For example: 27000@license-3.companyname.com

e Click OK.

The license server and license configuration are migrated to the destination machine.
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Postupgrade Considerations for
vCenter Server 6

After you upgrade to vCenter Server, consider the postupgrade options and requirements.

n To view the database upgrade log, open %TEMP%\VCDatabaseUpgrade.log.

n Install the vSphere Client and make sure you can access the vCenter Server instance.

n Upgrade any additional modules that are linked to this instance of vCenter Server. Additional modules
might include vCenter Update Manager, vCenter Converter, and vCenter Guided Consolidation, for
example.

n On the VMware Web site, log in to your account page to access the license portal. From the license portal,
upgrade your VirtualCenter 2.x license. Using the vSphere Client, assign the upgraded license key to the
vCenter Server 4.1 host.

n In the vSphere Client, select Home > vCenter Server Settings > Licensing to verify that the vCenter Server
is connected to a license server. A license server is required if this vCenter Server is managing ESX 3.x/ESXi
3.5 hosts. For information about installing the VMware License Server, see the documentation for VMware
Infrastructure 3.

n For Oracle databases, copy the Oracle JDBC Driver (ojdbc14.jar) driver to the[VMware vCenter
Server]\tomcat\lib folder.

n For SQL Server databases, if you enabled bulk logging for the upgrade, disable it after the upgrade is
complete.

n Optionally, join the vCenter Server system to a Linked Mode group.

n Optionally, upgrade the ESX/ESXi hosts in the vCenter Server inventory to ESX 4.1/ESXi 4.1.

n Optionally, enable SSL certification checking. Select Home > vCenter Server Settings > SSL Settings.
Select vCenter requires verified host SSL certificates and click OK. When you enable SSL checking, the
hosts become disconnected from vCenter Server, and you must reconnect them.

This chapter includes the following topics:

n “Upgrade the vSphere Client,” on page 52

n “Using a License Server to Manage ESX 3.x/ESXi 3.5 Hosts,” on page 52

n “License Server Scenarios,” on page 53

n “Join a Linked Mode Group After a vCenter Server Upgrade,” on page 53

n “Set the Maximum Number of Database Connections After a vCenter Server Upgrade,” on page 54

n “Restore VirtualCenter 2.5,” on page 55
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Upgrade the vSphere Client
Virtual machine users and vCenter Server administrators must use the vSphere Client 4.1 to connect to vCenter
Server 4.1 or to connect directly to ESX 4.1 hosts.

The VI Client 2.5 and the vSphere Client 4.0 can be installed on the same machine.

The vSphere Client upgrade operation requires no downtime. No virtual machines or clients need to be
powered off for this process.

Procedure

1 (Optional) Use Add/Remove Programs from the Windows Control Panel to remove any previous vCenter
Server client.

Older vCenter Server clients do not need to be removed and are useful if you need to connect to legacy
hosts.

2 Install the vSphere Client 4.1.

3 (Optional) Install vSphere Host Update Utility.

Install this utility if your environment does not use vCenter Update Manager and you want to use this
workstation to initiate upgrades of ESX 3.x/ESXi 3.5 hosts and manage ESXi host patching.

After you install the vSphere Client 4.1, you can connect to vCenter Server using the domain name or IP address
of the Windows machine on which vCenter Server is installed and the user name and password of a user on
that machine.

If you do not have the VI Client 2.5 installed and you use vSphere Client to connect to VirtualCenter 2.5, the
vSphere Client prompts you to download and install the VI Client 2.5. After you install the VI Client 2.5, you
can use the vSphere Client log-in interface to connect to VirtualCenter 2.5 or vCenter Server 4.1.

What to do next

Use the vSphere Client to connect to the vCenter Server IP address with your Windows login username and
password. Specifically, use the login credentials appropriate to the Windows machine on which vCenter Server
is installed. The vCenter Server username and password might be different than the username and password
you use for ESX/ESXi.

If the vSphere Client displays security alerts and exceptions when you log in or perform some operations, such
as opening performance charts or viewing the Summary tab, this might mean that your Internet Explorer (IE)
security settings are set to High. If your IE security settings are set to High, enable the Allow scripting of
Internet Explorer web browser control setting in IE.

If you cannot connect to the vCenter Server system, you might need to start the VMware VirtualCenter Server
service manually. To start the service, in the Settings menu, select Control Panel > Administrative Tools >
Services > VMware VirtualCenter Server. The machine might require several minutes to start the service.

Using a License Server to Manage ESX 3.x/ESXi 3.5 Hosts
vCenter Server 4.0 does not require a license server to manage ESX 4.0/ESXi 4.0 hosts. vCenter Server 4.0
requires a license server to manage ESX 3.x/ESXi 3.5 hosts.

If you do not have a license server installed and you need one, download the VMware License Server from the
VMware Web site.

The License Server installation requires no downtime. No virtual machines, servers, hosts, or clients need to
be powered off for the installation of the license server.
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License Server Scenarios
If you upgrade to vCenter Server 4.0 and you want the vCenter Server system to manage ESX 3.x/ESXi 3.5
hosts, you might need to verify that the license server is running and reconfigure vCenter Server 4.0 to point
to the license server, depending on your upgrade scenario.

Table 6-1 lists the license server scenarios and the necessary actions.

Table 6-1.  License Server Scenarios

Upgrade Scenario Necessary Action

In-place upgrade from VirtualCenter 2.x to vCenter Server. License server is on the same
machine.

None

In-place upgrade from VirtualCenter 2.x to vCenter Server. License server is on a different
machine.

None

Uninstall VirtualCenter 2.x. Preserve the license server. Perform a clean installation of
vCenter Server with a rebuilt, clean database.

Point vCenter Server to the
existing license server.

Uninstall VirtualCenter 2.x and the license server. Perform a clean installation of
vCenter Server with a rebuilt, clean database.

Install a new license server, and
point vCenter Server to the new
license server.

Clean installation of vCenter Server with a rebuilt, clean database. License server was on
a different machine.

Point vCenter Server to the
existing license server.

Upgrade to vCenter Server using a different machine. The VirtualCenter 2.x system is
the source machine. The vCenter Server 4.0 system is the destination machine.
See Chapter 5, “Upgrade to vCenter Server on a Different Machine and Upgrade the
Existing Database,” on page 39.

Point vCenter Server to the
existing license server.

Join a Linked Mode Group After a vCenter Server Upgrade
After you upgrade a machine to vCenter Server 4.1, you can join the system to a Linked Mode group.

Prerequisites

Before you join a Linked Mode group, review the Linked Mode prerequisites and considerations. See the ESX
and vCenter Server Installation Guide, the ESXi Installable and vCenter Server Setup Guide, or the ESXi Embedded
and vCenter Server Setup Guide.

Procedure

1 From the Start menu, select All Programs > VMware > vCenter Server Linked Mode Configuration.

2 Click Next.

3 Select Modify linked mode configuration and click Next.

4 Click Join vCenter Server instance to an existing linked mode group or another instance and click
Next.

5 Enter the server name and LDAP port number of any remote vCenter Server that is or will be a member
of the group and click Next.

If you enter an IP address for the remote server, the installer converts it into a fully qualified domain name.

Chapter 6 Postupgrade Considerations for vCenter Server

VMware, Inc.  53



6 If the vCenter Server installer detects a role conflict, select how to resolve the conflict.

Option Description

Yes, let VMware vCenter Server
resolve the conflicts for me

Click Next.
The role on the joining system is renamed to vcenter_namerole_name where
vcenter_name is the name of the vCenter Server system that is joining the
Linked Mode group and role_name is the name of the original role.

No, I'll resolve the conflicts myself To resolve the conflicts manually:
a Using the vSphere Client, log in to the vCenter Server system that is

joining the Linked Mode group using an account with Administrator
privileges.

b Rename the conflicting role.
c Close the vSphere Client session and return to the vCenter Server

installer.
d Click Back, and click Next.
The installation continues without conflicts.

 
A conflict results if the joining system and the Linked Mode group each contain a role with the same name
but with different privileges.

7 Click Finish.

vCenter Server restarts. Depending on the size of your inventory, the change to Linked Mode might take
from a few seconds to a few minutes to complete.

The vCenter Server instance is now part of a Linked Mode group. It might take several seconds for the global
data (such as user roles) that are changed on one machine to be visible on the other machines. The delay is
usually 15 seconds or less. It might take a few minutes for a new vCenter Server instance to be recognized and
published by the existing instances, because group members do not read the global data very often.

After you form a Linked Mode group, you can log in to any single instance of vCenter Server and view and
manage the inventories of all the vCenter Servers in the group.

What to do next

For more information about Linked Mode groups, see the vSphere Datacenter Administration Guide.

Set the Maximum Number of Database Connections After a vCenter
Server Upgrade

By default, a vCenter Server creates a maximum of 10 simultaneous database connections. If you configure
this setting in the previous version of vCenter Server and then perform the upgrade to vCenter Server 4.1, the
upgrade restores the default setting of 10. You can reconfigure the nondefault setting.

You do not need to change this value. You might want to increase this number if the vCenter Server frequently
performs many operations and performance is critical. You might want to decrease this number if the database
is shared and connections to the database are costly. VMware recommends that you not change this value
unless your system has one of these problems.

Perform this task before you configure the authentication for your database. For more information on
configuring authentication, see the documentation for your database.

Procedure

1 From a vSphere Client host that is connected to a vCenter Server system, select Administration > vCenter
Server Configuration and click Database.

2 In the Current vCenter Server menu, select the appropriate server.

3 In Maximum number, type the number.
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4 Restart the vCenter Server.

The new database setting takes effect.

Restore VirtualCenter 2.5
You can restore the previous VirtualCenter configuration if you have a full backup of your VirtualCenter
database and the previous VirtualCenter SSL certificates.

Prerequisites

You might need some or all of the following items to restore VirtualCenter and its components in the event of
a system failure or disaster. Follow your company disaster recovery guidelines for storage and handling of
these items.

n Installation media for the same version of VirtualCenter you are restoring

n VMware Infrastructure 3 license file or a running license server

n Database backup files

n SSL files found in: %ALLUSERSPROFILE%\Application Data\VMware\VMware VirtualCenter\SSL on the
VirtualCenter system

n Notes from the original installation regarding the selections, settings, and information used

n vpxd.cfg

n vCenter Server 4.x and ESX 4.x/ESXi 4.x license keys

Procedure

1 Completely uninstall vCenter Server 4.x.

2 Restore the previous version of the VirtualCenter database from the backup.

See your database documentation.

3 Reinstall your original version of VirtualCenter, selecting the restored database during the installation
process.

4 Verify that the license server is running if one was in use in the original installation.

5 Restore the VirtualCenter SSL certificate folder and vpxd.cfg to the %ALLUSERSPROFILE%\Application
Data\VMware\VMware VirtualCenter directory.

6 Make sure the system DSN points to the database.
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Upgrading Datastore and Network
Permissions 7

In previous releases of vCenter Server, datastores and networks inherited access permissions from the
datacenter. In vCenter Server 4.0 and higher, they have their own set of privileges that control access to them.
This might require you to manually assign privileges, depending on the access level you require.

In vCenter Server 4.x, users are initially granted the No Access role on all new managed objects, including
datastores and networks. This means, by default, users cannot view or perform operations on them. All existing
objects in vCenter Server maintain their permissions after the upgrade. To determine whether to assign
permissions to existing datastores and networks, the upgrade process uses the datacenter's Read-only
privilege.

n If the Read-only privilege is nonpropagating (not inherited by child objects), VMware assumes access
privileges should not be assigned to datastores and networks. In such cases, you must update your roles
to include the new datastore and network privileges desired. This is required for users to view and perform
operations on these objects.

n If the Read-only privilege is propagating (inherited by child objects), VMware assumes access privileges
should be assigned to datastores and networks so users can view them and perform basic operations that
require access. In such cases, the default minimum privileges are automatically assigned during the
upgrade process.

After the upgrade process, if your roles require users to have additional privileges, for example, the ability
to delete a datastore or network, you need to update your permission roles.

Table 7-1 lists the privileges assigned to datastores and networks before the upgrade to vCenter 4.1 and after
the upgrade to vCenter 4.1, and the action required by administrators to enable access.

Table 7-1.  Datastore and Network Permission Requirements

Object Before Upgrade Privilege After Upgrade Privilege Action Required to Enable Access

Datastore Nonpropagating Read-only No Access Assign access privileges for datastores or
datastore folders.

Propagating Read-only Allocate Space None.

Network Nonpropagating Read-only No Access Assign access privileges for networks or
network folders.

Propagating Read-only Assign Network None.

NOTE   The Read-only propagating permission on a datacenter, as well as all other permissions you have set,
will continue to work as expected after the upgrade.
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This chapter includes the following topics:

n “Datastore Privileges,” on page 58

n “Network Privileges,” on page 58

n “Update Datastore Permissions,” on page 59

n “Update Network Permissions,” on page 60

Datastore Privileges
In VMware vSphere 4.0 and higher, datastores have their own set of access control privileges. As a result, you
might need to reconfigure your permissions to grant the new datastore privileges. This is required if you have
nonpropagating Read-only permission set on the datacenter for users.

Table 7-2 lists the default datastore privileges that, when selected for a role, can be paired with a user and
assigned to a datastore.

Table 7-2.  Datastore Privileges

Privilege Name Actions Granted to Users Affects
Pair with
Object

Effective on
Object

Allocate Space Allocate space on a datastore for a virtual
machine, snapshot, or clone.

hosts, vCenter
Servers

datastores datastores,
virtual disks

Browse Datastore Browse files on a datastore, including CD-
ROM or Floppy media and serial or parallel
port files. In addition, the browse datastore
privilege allows users to add existing disks
to a datastore.

hosts, vCenter
Servers

datastores datastores,
datastore folders,
hosts, virtual
machines

Delete Datastore Remove a datastore. hosts, vCenter
Servers

datastores datastores,
datastore folders

Delete Datastore
File

Delete a file in the datastore. hosts, vCenter
Servers

datastores datastores

File Management Carry out file operations in the datastore
browser.

hosts, vCenter
Servers

datastores datastores

Move Datastore Move a datastore between folders in the
inventory.
NOTE   Privileges are required on both the
source and destination objects.

vCenter Servers datastore,
source and
destination
object

datastores,
datastore folders

Rename Datastore Rename a datastore. hosts, vCenter
Servers

datastores datastores

Network Privileges
In VMware vSphere 4.0 and higher, networks have their own set of access control privileges. As a result, you
might need to reconfigure your permissions to grant the new network privileges. This is required if you have
nonpropagating Read-only permission set on the datacenter.

Table 7-3 lists the default network privileges that, when selected for a role, can be paired with a user and
assigned to a network.
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Table 7-3.  Network Privileges

Privilege Name Actions Granted to Users Affects
Pair with
Object

Effective on
Object

Assign Network Assign a network to a virtual
machine.

VCenter Servers virtual
machine

network, virtual
machine

Configure
Network

Configure a network. hosts, vCenter Servers network,
network
folder

networks, virtual
machines

Delete Network Remove a network. hosts, vCenter Servers datacenter datacenters

Move Network Move a network between folders in
the inventory.
NOTE   Privileges are required on both
the source and destination objects.

hosts, vCenter Servers network,
source and
destination

networks

Update Datastore Permissions
You must change Read-only nonpropagating datastore permissions to propagating datastore permissions in
order for users to access the datastores. You can assign datastore permissions on datastores or folders
containing datastores.

Prerequisites

Before performing the upgrade procedure, determine which users need access to each datastore and which
privileges each user needs. If necessary, define new datastore roles or modify the Database Consumer sample
role. This sample role assigns the Allocate Space privilege to the datastore, which enables users to perform
basic virtual machine operations, such as creating clones and taking snapshots. In addition, organize your
datastores in folders that coincide with users' access needs.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you have set,
will be kept intact after the datastore permissions upgrade.

Procedure

1 Log in to vSphere Client as an administrator.

2 On the Home page, click Datastores to display the datastores in the inventory.

3 Select the datastore or datastore folder and click the Permissions tab.

4 Right-click in the Permissions tab and from the context pop-up menu, choose Add Permission.

5 In the Assigned Role pane, assign a role.

n To assign specific datastore privileges defined in a role by your company, choose the custom role.

n To migrate read-only nonpropagating datacenter permissions to propagating datastore permissions,
choose Datastore Consumer (sample). This role assigns the Allocate Space privilege to users, which
is required so that users can consume space on the datastores on which this role is granted. In order
to perform a space-consuming operation, such as creating a virtual disk or taking a snapshot, the user
must also have the appropriate virtual machine privileges granted for these operations.

n To assign Read-only datastore privileges, choose Read-only.

This role enables users to browse the datastore without giving them other datastore privileges. For
example, choose Read-only for users who need to attach CD/DVD-ROM ISO images to a datastore.

6 Select Propagate to Child Objects.

7 In the Users and Groups pane, click Add.
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8 Select the users and groups for whom to add the role.

To select multiple names, control-click each additional name.

9 Click OK.

All users are added to the Users and Groups list for this role.

10 Click OK.

The datastore is saved with the new permissions.

NOTE   You need to set up permissions for new datastores that you create. By default, new datastores are created
under the datacenter folder in the inventory. You can move it into a datastore folder, as appropriate.

Update Network Permissions
You must change Read-only nonpropagating network permissions to propagating network permissions in
order for users to access the networks. You can assign network permissions on networks or folders containing
networks.

Before performing the update procedure, determine the network organization for virtual machines, hosts, and
users. If necessary, define new networking roles or modify the Network Consumer sample role. This sample
role assigns the Assign Network privilege. In addition, group your networks in folders that coincide with your
organizational needs.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you have set,
will be kept intact after the network permissions upgrade.

Procedure

1 Log in to vSphere Client as an administrator.

2 On the Home page, click Networking to display the networks in the inventory.

3 Select the network or network folder and click the Permissions tab.

4 Right-click in the Permissions tab and from the context menu, choose Add Permission.

5 In the Assigned Role pane, do one of the following:

n To assign specific network privileges defined in a role by your company, choose the custom role.

NOTE   The Read-only propagating permission on a datacenter, in addition to all permissions you
have set, will be kept intact after the upgrade.

n To migrate read-only nonpropagating datacenter permissions to propagating network permissions,
choose Network Consumer (sample). This role assigns the Assign Networkprivilege to users, which
is required so that users can associate a virtual machine's vNIC or host's NIC with the network on
which this role is granted. This requires the appropriate permissions for the assignment are also
granted on the virtual machines or hosts.

6 Select Propagate to Child Objects.

7 In the Users and Groups pane, click Add.

8 Select the users and groups for whom to add the role.

To select multiple names, control-click each additional name.

9 Click OK.

All users are added to the Users and Groups list for this role.

10 Click OK.
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New networks that you create are added under the datacenter by default.

NOTE   You need to set up permissions for new networks that you create. By default, new networks are created
under the datacenter folder in the inventory. You can move it into a network folder, as appropriate.
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Preparing for the Upgrade to ESX
4.1/ESXi 4.1 8

After completing the upgrade to vCenter Server, upgrade legacy VMware ESX/ESXi hosts to ESX 4.1/ESXi 4.1.

These topics are intended for administrators who are upgrading ESX, ESXi, and virtual machines from
ESX 4.0/ESXi 4.0 to ESX 4.1/ESXi 4.1.

To upgrade directly from ESX 3.5/ESXi 3.5 to ESX 4.1/ESXi 4.1, use VMware vCenter Update Manager. For
information on upgrading from ESX 3.5/ESXi 3.5 to ESX 4.1/ESXi 4.1, see the vSphere Update Manager
Administration Guide.

This chapter includes the following topics:

n “About Host Upgrades,” on page 64

n “Release Upgrade Support for ESX/ESXi,” on page 64

n “vSphere Host Update Utility,” on page 65

n “vCenter Update Manager,” on page 66

n “Recommendation for Static IP Addresses,” on page 67

n “vSphere Components Upgraded by Update Manager,” on page 67

n “Preserved Configuration Components,” on page 67

n “Non-Preserved Configuration Components,” on page 69

n “Back Up the ESX Host Configuration,” on page 69

n “Back Up the ESXi Host Configuration,” on page 69

n “Best Practices for Upgrades,” on page 70
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About Host Upgrades
To upgrade to vSphere 4.1, upgrade hosts with service consoles to ESX 4.1 (which also has a service console).
Upgrade hosts without service consoles to ESXi 4.1 (which does not have a service console). You cannot use
the upgrade tools to convert ESX hosts to ESXi hosts, or the reverse.

VMware provides the following tools for upgrading ESX/ESXi hosts:

vSphere Host Update
Utility

Graphical utility for standalone hosts. Allows you to perform remote upgrades
of ESX 3.x/ESXi 3.5 hosts to ESX 4.0/ESXi 4.0. vSphere Host Update Utility
upgrades the virtual machine kernel (vmkernel) and the service console, where
present. vSphere Host Update Utility does not upgrade VMFS datastores or
virtual machine guest operating systems.

vCenter Update Manager Robust software for upgrading, updating, and patching clustered hosts, virtual
machines, and guest operating systems. Orchestrates host and virtual machine
upgrades. If your site uses vCenter Server, VMware recommends that you use
vCenter Update Manager. See the VMware vCenter Update Manager Installation
and Adminstration Guide accessible on the VMware vCenter Update Manager
Documentation page: 
http://www.configuresoft.net/support/pubs/vum_pubs.html

vihostupdate Command-line utility for ESX and ESXi. This utility requires the vSphere CLI.

esxupdate Command-line utility for ESX only.

Release Upgrade Support for ESX/ESXi
To upgrade virtual machines from ESX to ESXi (or from ESXi to ESX), you must perform a migration upgrade.
You cannot perform an in-place upgrade from ESX to ESXi (or from ESXi to ESX). If a VMware ESX/ESXi
version does not have upgrade support, perform a clean installation, after you save your VMFS datastore to
another location or partition.

NOTE   For Table 8-1 and Table 8-2 the following details apply:

n For more information about host upgrade and patch baseline, see the VMware vCenter Update Manager
Installation and Administration Guide accessible on the VMware vCenter Update Manager Documentation
page: http://www.configuresoft.net/support/pubs/vum_pubs.html.

n The VersionInfo place holder used in file names, represents specific ESX or ESXi version information.

Table 8-1 provides information about upgrade support for ESX. Upgrade support for a version of ESX usually
includes all associated update releases. For example, where upgrading from ESX 4.0 is supported, upgrades
from ESX 4.0 Update 1, ESX 4.0 Update 2, and so on are included. However, check the release notes of the ESX
version to which you are upgrading for greater detail on ESX upgrade support.

Table 8-1.  Upgrade Support to ESX 4.1 (includes support to ESX 4.1 updates)

From ESX Version File Name Upgrade Tools Supported

ESX alpha, beta, or RC
release (any)

N/A No upgrade support

ESX 1.x N/A No upgrade support

ESX 2.5.x N/A No upgrade support

ESX 3.0.x N/A No upgrade support

vSphere Upgrade Guide

64  VMware, Inc.

http://www.configuresoft.net/support/pubs/vum_pubs.html
http://www.configuresoft.net/support/pubs/vum_pubs.html


Table 8-1.  Upgrade Support to ESX 4.1 (includes support to ESX 4.1 updates) (Continued)

From ESX Version File Name Upgrade Tools Supported

ESX 3.5 (offline bundle)
Support applies to ESX
3.5 Update 5a only.

This file is a .iso file such as the following:
n ESX-4.1.0-VersionInfo.iso

n vCenter Update Manager 4.1 - host
upgrade baseline

ESX 4.0 (offline bundle) These files are .zip files such as the following:
n upgrade-from-esx4.0-to-4.1VersionInfo.zip
n pre-upgrade-from-esx4.0-

to-4.1VersionInfo.zip

Install the pre-upgrade bulletin if you plan to use
the vihostupdate utility or the esxupdate
utility to get the new installer on the ESX server.

n vCenter Update Manager 4.1 - host
upgrade baseline

n vihostupdateutility
n esxupdate utility

ESX 4.1 (offline bundle) This file is a.zip file such as the following:
n update-from-esx4.1-4.1_VersionInfo.zip

n vCenter Update Manager 4.1 - patch
baseline

n vihostupdate utility
n esxupdate utility

ESX 4.1 (online patch) This file is a roll up bulletin such as the following:
n ESX410-VersionInfo

n vCenter Update Manager 4.1 - patch
baseline

Table 8-2 provides details of upgrade support for ESXi. Upgrade support for a version of ESXi usually includes
all associated update releases. For example, where upgrading from ESXi 4.0 is supported, upgrades from
ESXi 4.0 Update 1, ESX 4.0 Update 2, and so on are included. However, check the release notes of the ESXi
version to which you are upgrading for greater detail on ESXi upgrade support.

Table 8-2.  Upgrade Support to ESXi 4.1 (includes support to ESXi 4.1 updates)

From ESXi Version Upgrade Tools Supported

ESXi 3.5 (offline bundle)
Support applies to ESXi 3.5
Update 5 only.

This file is a .zip file such as the following:
n upgrade-from-esxi3.5-

to-4.1_VersionInfo.zip

n vCenter Update Manager 4.1 - host
upgrade baseline

ESXi 4.0 (offline bundle) This file is a .zip file such as the following:
n upgrade-from-esxi4.0-

to-4.1_VersionInfo.zip

n vCenter Update Manager 4.1 - host
upgrade baseline

n vihostupdate utility

ESXi 4.1 (offline bundle) This file is a .zip file such as the following:
n update-from-esxi

4.1-4.1_VersionInfo.zip

n vCenter Update Manager 4.1 -
patch baseline

n vihostupdate utility

ESXi 4.1 (online patch) This file is a roll up bulletin such as the following:
n ESXi410-VersionInfo

n vCenter Update Manager 4.1 -
patch baseline

vSphere Host Update Utility
When you install the vSphere Client, you can also install vSphere Host Update Utility. vSphere Host Update
Utility is a standalone Microsoft Windows application recommended for deployments with fewer than
ten ESX/ESXi hosts, and without vCenter Server or Update Manager.

vSphere Host Update Utility provides a way to upgrade from a remote location, without a CD, and with
minimum downtime. The application upgrades the virtual machine kernel (vmkernel) and the service console,
where present. vSphere Host Update Utility does not upgrade VMFS datastores or virtual machine guest
operating systems.

You can use vSphere Host Update Utility to upgrade ESX 3.x to ESX 4.0 and ESXi 3.5 hosts to ESXi 4.0. You
cannot use vSphere Host Update Utility to convert ESX hosts to ESXi hosts, or the reverse.
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When you select a host to be upgraded, the tool performs an automated host compatibility check as a
preupgrade step. The check verifies that each host is compatible with ESX 4.0/ESXi 4.0, including the required
CPU, and has adequate boot and root partition space. In addition to the automated preupgrade script, you can
specify a postupgrade configuration script to ease deployment. This tool effectively eliminates the need for
complex scripted upgrades.

The Host Upgrade wizard allows you to make upgrade configuration choices. Your choices are saved in an
installation script, which the software uploads to the selected host with the installation ISO image or ZIP file.
vSphere Host Update Utility supports local or remote mounted ISO binary image files, and ZIP files.

The software initiates the upgrade by rebooting the host and running the upgrade script. While an upgrade is
in progress, vSphere Host Update Utility provides visual status so that you can monitor the status of the
upgrade. If an error occurs during this process, the software rolls back the host software to the previous ESX
version.

vSphere Host Update Utility also lets you learn about, download, and install maintenance and patch releases,
which provide security, stability, and feature enhancements for ESXi 4.0.

System Requirements for vSphere Host Update Utility
vSphere Host Update Utility has the same system requirements as the vSphere Client.

To use vSphere Host Update Utility, you must have the following items:

n A workstation or laptop with vSphere Host Update Utility installed.

vSphere Host Update Utility is bundled with the vSphere Client. You can install vSphere Host Update
Utility when you install the vSphere Client. If the vSphere Client is already installed but vSphere Host
Update Utility is not installed, you can install an updated version by rerunning the vSphere Client installer.

n A network connection between the host and the computer that is running vSphere Host Update Utility.

vCenter Update Manager
Orchestrated upgrades allow you to upgrade the objects in your vSphere inventory in a two-step process: host
upgrades followed by virtual machine upgrades. You can configure the process at the cluster level for higher
automation, or you can configure it at the individual host or virtual machine level for granular control.

For example, you can define a host upgrade baseline to upgrade an ESX 3.5 host to ESX 4.1, or you can define
a virtual machine upgrade baseline to upgrade the VMware Tools and the virtual machine hardware to the
latest version. To do this, you use wizard-based workflows to first schedule host upgrades for an entire cluster
and then schedule a virtual machine upgrade for all the virtual machines.

Built-in best practices in the wizard workflows preclude erroneous upgrade sequences. For example, the
wizard prevents you from upgrading virtual machine hardware before you upgrade hosts in a cluster.

You can use Distributed Resource Scheduler (DRS) to prevent virtual machine downtime during the upgrade
process.

Update Manager monitors hosts and virtual machines for compliance against your defined upgrade baselines.
Noncompliance appears in detailed reports and in the dashboard view. Update Manager supports mass
remediation.

See the VMware vCenter Update Manager Installation and Adminstration Guide accessible on the VMware vCenter
Update Manager Documentation page: http://www.configuresoft.net/support/pubs/vum_pubs.html.

Orchestrated Upgrade of Hosts Scenario
Update Manager allows you to perform orchestrated upgrades of the ESX/ESXi hosts in your vSphere inventory
using a single upgrade baseline.

You can perform orchestrated upgrades of hosts at the folder, cluster, or datacenter level.
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Recommendation for Static IP Addresses
VMware recommends that you use static IP addresses for ESX/ESXi hosts. During host upgrade, static IP
addresses are a requirement.

DHCP IP addresses can cause problems during host upgrades. Suppose, for example, a host loses its DHCP
IP address during the upgrade because the lease period configured on the DHCP server expires. The host
upgrade tool that you are using (for example, vCenter Update Manager) would lose connectivity to the host.
The host upgrade might be successful, but the upgrade tool would report the upgrade as failed, because the
tool would be unable to connect to the host. To prevent this scenario, use static IP addresses for your hosts.

vSphere Components Upgraded by Update Manager
Multiple VMware vSphere components are upgraded when you upgrade using Update Manager.

The following vSphere components are upgraded by Update Manager.

n Virtual machine kernel (vmkernel)

n Service console, where present

n Virtual machine hardware

n VMware Tools

n Guest operating systems service packs and patch releases

For components that are not listed here, you can perform the upgrade by using the appropriate third-party
tools or by using other upgrade methods.

After the upgrade to ESX 4.1, the service console's partitions are stored in a .vmdk file. These partitions
include /, swap, and all the optional partitions. The name of this file is esxconsole-system-
uuid/esxconsole.vmdk. All .vmdk files, including the esxconsole.vmdk, are stored in VMFS volumes.

Preserved Configuration Components
When you upgrade to ESX 4.1/ESXi 4.1, the host upgrade process preserves many components of the
ESX 3.5/ESXi 3.5 or ESX 4.0/ESX 4.1 configuration.

ESXi
For ESXi, the upgrade to ESXi 4.1 preserves almost all configuration data, including your networking, security,
and storage configuration. The only configuration not preserved is related to licensing while doing upgrade
from 3.5 to 4.1, because a new ESXi 4.1 license is required after the upgrade.

ESX
For ESX, the upgrade reuses the existing /boot partition to hold the ESX 4.1 boot files.

For upgrades from ESX 3.5 to ESX 4.1 using vCenter Update Manager, the ESX 3.5 installation is mounted in
the new ESX 4.1 installation under the /esx3-installation directory after the upgrade.

The upgrade to ESX 4.1 preserves almost all configuration data, including your networking, security, and
storage configuration. Specifically, the upgrade to ESX 4.1 preserves the following files from the ESX 3.5 files
system and in ESX 4.0 it preserves all the files which are mentioned below excluding kerberoes configuration
(/etc/krb.conf,n /etc/krb.realmsn, /etc/krb5.conf).

n /etc/logrotate.conf

n /etc/localtime
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n /etc/ntp.conf

n /etc/syslog.conf

n /etc/sysconfig/ntpd

n /etc/sysconfig/xinetd

n /etc/sysconfig/console

n /etc/sysconfig/i18n

n /etc/sysconfig/clock

n /etc/sysconfig/crond

n /etc/sysconfig/syslog

n /etc/sysconfig/keyboard

n /etc/sysconfig/mouse

n /etc/ssh

n /etc/yp.conf

n /etc/krb.conf

n /etc/krb.realms

n /etc/krb5.conf

n /etc/login.defs

n /etc/pam.d

n /etc/hosts.allow

n /etc/hosts.deny

n /etc/ldap.conf

n /etc/openldap

n /etc/sudoers

n /etc/snmp

n /usr/local/etc

n /etc/rc.d/rc*.d/*

n /etc/xinetd.conf

n /etc/motd

n /etc/initiatorname.vmkiscsi

n /etc/vmkiscsi.conf

NOTE   To migrate other files, consider using a postupgrade script. For example, you might want to create a
script that copies the .ssh directory for root.
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Non-Preserved Configuration Components
When you upgrade to ESX 4.1/ESXi 4.1, some components that might have been modified in the ESX 3.5/ESXi 3.5
or ESX 4.0/ESX 4.0 configuration are not preserved.

ESXi
For ESXi, if you modified certain files in the ESXi 3.5 or ESXi 4.0 configuration, the modified configuration is
not retained after the upgrade to ESXi 4.1. Modifications to the following files are not retained after the upgrade.

n /etc/sfcb/sfcb.cfg

n inetd.conf

n motd

n issue

n inittab

n chkconfig.db

ESX
For ESX, if you modified certain files in the ESX 3.5 or ESX 4.0 configuration, the modified configuration is not
retained after the upgrade to ESX 4.1. Modifications to the following files are not retained after the upgrade.

n /etc/sfcb/sfcb.cfg

n /etc/vmware/firewall/services.xml

Resource Pool settings configured in ESX 3.5 might not be preserved after upgrade. This loss of configuration
can happen in upgrade scenarios where there are no free resources.

Back Up the ESX Host Configuration
Before you upgrade an ESX host, back up the local VMFS file system. This backup ensures that you will not
lose data during the upgrade.

Procedure

n Back up the files in the /etc/passwd, /etc/groups, /etc/shadow, and /etc/gshadow directories.

The /etc/shadow and /etc/gshadow files might not be present on all installations.

n Back up any custom scripts.

n Back up local images, such as templates, exported virtual machines, and .iso files.

Back Up the ESXi Host Configuration
Back up the host configuration before you begin a host upgrade.

For more information about the VMware vSphere Command-Line Interface and the vicfg-cfgbackup
command, see the vSphere Command-Line Interface Installation and Reference Guide

Procedure

1 Install the vSphere CLI.
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2 In the vSphere CLI, run the vicfg-cfgbackup command with the -s flag to save the host configuration to
a specified backup filename.

 vicfg-cfgbackup --server <ESXi-host-ip> --portnumber <port_number> --protocol 

<protocol_type> --username username --password <password> -s <backup-filename>

Best Practices for Upgrades
Follow best practices when you upgrade on hosts.

To ensure that each upgrade is successful, use the following strategy:

n After the upgrade, test the system to ensure that the upgrade was completed successfully.

n If the upgrade was unsuccessful, revert to the last good known image. See “Roll Back an ESXi
Upgrade,” on page 85 or “Roll Back an ESX Upgrade,” on page 85.
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Upgrading to ESX 4.1 or ESXi 4.1 9
There a several tools available for upgrading hosts. You can use different upgrade tools based depending on
the type of host you are upgrading (ESX or ESXi) and whether the hosts are managed by vCenter Server.

You can upgrade from ESX/ESXi 4.0 to ESX/ESXi 4.1 with the tools described here. You can upgrade ESX/ESXi
3.5 directly to ESX/ESXi 4.1 using vCenter Update Manager. Alternatively, you can upgrade from ESX/ESXi
3.5 to ESX/ESXi 4.0 and then use the tools described here to upgrade from ESX/ESXi 4.0 to ESX/ESXi 4.1. See
the VMware vSphere 4.0 documentation Web page for information on upgrading from ESX/ESXi 3.5 to
ESX/ESXi 4.0.

In-place upgrades of hosts from ESXi 4.0 to ESXi 4.1 are supported using the vihostupdate command-line
utility. vihostupdate requires the vSphere Command-Line Interface (vSphere CLI).

In-place upgrades of ESX 4.0 to ESX 4.1 are supported using the vihostupdate command-line utility and the
esxupdate command-line utility.

Upgrades from ESX/ESXi 3.5 and ESX/ESXi 4.0 to ESX/ESXi 4.1 are also supported using vCenter Update
Manager. See the VMware vCenter Update Manager Installation and Adminstration Guide accessible on the VMware
vCenter Update Manager Documentation page: http://www.configuresoft.net/support/pubs/vum_pubs.html.

CAUTION  
n If you are upgrading hosts managed by vCenter Server, you must upgrade to vCenter Server before you

upgrade ESX/ESXi. If you do not upgrade in the correct order, you can lose data and lose access to your
servers.

n When you upgrade a host from ESX 3.x to ESX 4.x, the customized partitions in 3.x are not replicated in
4.x.

This chapter includes the following topics:

n “About Patching Hosts with vSphere Host Update Utility,” on page 72

n “About the vihostupdate Command-Line Utility,” on page 74

n “Upgrade an ESX Host with the vihostupdate Utility,” on page 75

n “Upgrade an ESXi Host with the vihostupdate Utility,” on page 76

n “Upgrade an ESX Host with the esxupdate Utility,” on page 78

n “Update an ESX/ESXi Host Using a Depot with the vihostupdate Utility,” on page 79

n “Uninstall a Bundle from a Host,” on page 79
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About Patching Hosts with vSphere Host Update Utility
With vSphere Host Update Utility, you can download and install maintenance and patch releases, which
provide security, stability, and feature enhancements for ESXi 4.1 hosts.

You can use vSphere Host Update Utility to check for new release updates and patches that are applicable to
the ESXi hosts registered in the vSphere Host Update Utility. vSphere Host Update Utility builds the host list
by tracking the hosts that you connect to directly through the vSphere Client. You can also add hosts to the
list manually.

System Requirements for vSphere Host Update Utility
vSphere Host Update Utility has the same system requirements as the vSphere Client.

To use vSphere Host Update Utility, you must have the following items:

n A workstation or laptop with vSphere Host Update Utility installed.

vSphere Host Update Utility is bundled with the vSphere Client. You can install vSphere Host Update
Utility when you install the vSphere Client. If the vSphere Client is already installed but vSphere Host
Update Utility is not installed, you can install an updated version by rerunning the vSphere Client installer.

n A network connection between the host and the computer that is running vSphere Host Update Utility.

Add a Host to the List
vSphere Host Update Utility compiles a list of ESX/ESXi hosts that you connect to directly by using the vSphere
Client. If the list is not complete, you can add hosts to be managed by vSphere Host Update Utility.

Prerequisites

The host must be reachable.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select Host > Add Host.

3 Enter the host name or IP address and click Add.

vSphere Host Update Utility verifies that the selected host is reachable and adds the host to the list.

What to do next

Scan hosts and apply available updates or upgrade a host.

Download Patches and Updates
For ESXi, you can download available host patches and maintenance updates.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select File > Download Patches from VMware.

vSphere Host Update Utility downloads patches and updates from the official servers.

What to do next

Scan the hosts and apply the updates and patches.
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Scan Hosts and Apply Available Updates and Patches
You can check whether updates are available for the reachable hosts in your datacenter.

When you select a patch to install, consider the following points:

n The patch might be part of a bulletin that includes multiple patches.

n The contents of bulletins might overlap with each other.

n The patch might depend on other patches as prerequisites.

n One patch might be a subset of another patch.

These behaviors are expected and are managed by vSphere Host Update Utility as needed. If you install a
patch, do not be concerned if vSphere Host Update Utility installs multiple patches.

Procedure

1 Select Start > Programs > VMware > vSphere Host Update Utility 4.0.

2 Select a host.

3 In the Host Details pane, click Scan for Patches.

4 Enter the host username and password and click Login.

5 (Optional) If updates are available, click Patch Host.

For each host that you scan, vSphere Host Update Utility downloads available updates to the host. After
the host is updated, an OK button appears.

6 Click OK.

After all updates are applied, vSphere Host Update Utility restarts the updated services.

What to do next

If you have multiple hosts, repeat this procedure until all hosts are updated.

Customizing vSphere Host Update Utility
If the default settings for vSphere Host Update Utility do not meet the needs of your environment, you can
customize the application.

Customize the application by modifying the settings.config XML file, located in the application folder. If
you installed the vSphere Client at the default location, the settings.config XML file is located at one of the
following locations:

n 32-bit OS: %PROGRAMFILES%\VMware\Infrastructure\VIUpdate 4.0

n 64-bit OS: %PROGRAMFILES(X86)%\VMware\Infrastructure\VIUpdate 4.0

You can make the following customizations in the settings.config file:

RemoteDepot URL of the remote server to retrieve host patches and updates.

LocalDepot Local path on your machine where host patches and updates are stored.

ProxyServer Proxy server to use for downloads. By default, this element is empty.

UserSettingsDirectory Directory where user settings are stored.

AskBeforeDownload Display a confirmation prompt to download patches from the VMware patch
repository. Can be True or False. By default, the value is set to True.
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About ESXi Boot and Standby Builds
ESXi hosts can store a boot build and a standby build.

For each update, the update utility updates the standby build. After the update, you then reboot the host. After
the host reboots, the standby build becomes the boot build, and the previous boot build becomes the standby
build. If the update is successful, the host continues to boot from the new boot build until the next update.

For example, suppose the current boot build is 52252 and the current standby build is 51605. When you update
the host to build 52386, the update process replaces build 51605 with build 52386 and makes build 52252 the
standby build. If the update is successful, you continue to boot from build 52386 until the next update.

If an update fails and the ESXi 4.x host cannot boot from the new build, the host reverts to booting from the
original boot build.

About the vihostupdate Command-Line Utility
The vihostupdate command upgrades ESX/ESXi hosts and installs and updates ESX/ESXi extensions such as
VMkernel modules, drivers, and CIM providers.

You must have the vSphere CLI installed to use the vihostupdate command.

NOTE   The esxupdate utility is also supported for upgrades to ESX 4.1. It is for ESX only.

The vihostupdate command works with bulletins. Each bulletin consists of one or more vSphere bundles and
addresses one or more issues.

Towards the end of a release, bulletins might include a large number of other bulletins. Bulletins are available
in offline bundles and in a depot with associated metadata.zip files.

n If you use offline bundles, all patches and corresponding metadata are available as one ZIP file.

n If you use a depot, the metadata.zip file points to metadata, which describes the location of the files.

The command supports querying installed software on a host, listing software in a patch, scanning for bulletins
that apply to a host, and installing all or some bulletins in the patch. You can specify a patch by using a bundle
ZIP file or a depot’s metadata ZIP file.

vihostupdate supports https://, http://, and ftp:// downloads. You can specify the protocols in the
download URL for the bundle or metadata file. vihostupdate also supports local paths. To search a local depot
where the vSphere CLI is installed, use /local/depot/metadata.zip without the file:/// parameter.

Towards the end of a release, bulletins might include a large number of other bulletins. Bulletins are available
in offline bundles in which all patches and corresponding metadata are available as two ZIP files.

The command supports querying installed software on a host, listing software in a patch, scanning for bulletins
that apply to a host, and installing all or some bulletins in the patch. You can specify a patch by using a bundle
ZIP file.

vihostupdate supports https://, http://, and ftp:// downloads. You can specify the protocols in the
download URL for the bundle. vihostupdate also supports local paths. To search a local depot where the
vSphere CLI is installed, use /local/depot/metadata.zip without the file:/// parameter.
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Upgrade an ESX Host with the vihostupdate Utility
You can use the vihostupdate utility to upgrade from ESX 4.0 to ESX 4.1.

Prerequisites

Before you can upgrade an ESX host from the command line, you must have access to a machine on which you
can run the VMware vSphere Command-Line Interface (vSphere CLI). You can install the vSphere CLI on a
Microsoft Windows or Linux system or import the VMware vSphere Management Assistant (vMA) virtual
appliance onto your ESX host. For information about importing or installing the vSphere CLI, see the VMware
vSphere Command-Line Interface Installation and Reference Guide.

The target host must have 2GB of RAM if it is connected to vCenter Server.

For ESX hosts, the following space requirements for partitions must be met.

n The /root partition must have at least 1.8GB.

n The /boot partition must have at least 24MB of free space.

Procedure

1 Download the following upgrade ZIP bundles from the VMware Web site to a location that is accessible
to the vSphere CLI machine.

n The esxupdate bulletin, pre-upgrade-from-ESX4.0-to-4.1.0-0.0.build#-release.zip

n The upgrade bulletin, upgrade-from-ESX4.0-to-4.1.0-0.0.build#-release.zip

2 Find out which bulletins are applicable to the ESX/ESXi host.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --scan --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --scan --bundle <local_path>/rollup.zip

The --server argument is the ESX/ESXi host name or IP address.

You can specify more than one bundle at the command line each time you run the command. For multiple
bundles, use a comma to separate the path and file name of the bundle. Do not include a space after the
comma.

3 (Optional) List all the bulletins that are available in the bundle.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --list --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --list --bundle <local_path>/rollup.zip

This command lists all the bulletins contained in the bundle, even those that do not apply to the host.
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4 Install bulletins from one or more bundles on the ESX/ESXi host.

n Install from an offline HTTP server. The following example installs both VMware bulletins and
bulletins made available by a partner.

vihostupdate.pl --server <server> --install --bundle 

http://<webserver>/rollup.zip,http://<webserver>/rollupPartner1.zip --bulletin 

bulletin1,bulletin2

n Install from the local machine. The following example installs both VMware bulletins and bulletins
made available by a partner.

vihostupdate.pl --server <server> --install --bundle 

<local_path>/rollup.zip,<local_path>/rollupPartner1.zip --bulletin bulletin1,bulletin2

If you omit the --bulletin argument, this command installs all the bulletins in the bundle.

5 From the service console, log on to the ESX 4.0 host as user root.

If you do not have direct access to the ESX 4.0 host, connect remotely to the service console using ssh.

6 Power off any virtual machines that are running on the host and place the host into maintenance mode.

7 Run the following command to enable an outgoing connection for the service console.

esxcfg-firewall --allowIncoming --allowOutgoing

8 Install the esxupdate bulletin by running the following command on the vSphere CLI machine.

vihostupdate -i --server host name or IP address --username root --password password -b 

location of the esxupdate ZIP bundle

9 Install the upgrade bulletin by running the following command on the vSphere CLI machine.

vihostupdate -i --server host name or IP address --username root --password password -b 

location of the ESX upgrade ZIP bundle

10 Verify that the bulletins are installed on the ESX host.

vihostupdate.pl --server host name or IP address --query

11 (Optional) Remove individual bulletins.

vihostupdate.pl --server <server> --remove --bulletin bulletin1

Use this option only for removing bulletins that are third-party or VMware extensions. Do not remove
bulletins that are VMware patches or updates. vihostupdate can remove only one bulletin at a time.

12 Reboot the host.

13 Reset the service console firewall to high security by running the following command.

esxcfg-firewall --blockOutgoing

Upgrade an ESXi Host with the vihostupdate Utility
You can use the vihostupdate utility to upgrade from ESXi 4.0 to ESXi 4.1.

Prerequisites

Before you can upgrade an ESXi host from the command line, you must have access to a machine on which
you can run the VMware vSphere Command-Line Interface (vSphere CLI). You can install the vSphere CLI on
a Microsoft Windows or Linux system or import the VMware vSphere Management Assistant (vMA) virtual
appliance onto your ESXi host. For information about importing or installing the vSphere CLI, see the VMware
vSphere Command-Line Interface Installation and Reference Guide.

The target host must have 3GB of RAM if it is connected to vCenter Server.
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For ESXi hosts, you must configure a scratch partition and reboot the host before proceeding with the upgrade.
You can configure a scratch partition for a host under the Software Advanced Settings in the Configuration
tab of the vSphere Client.

Procedure

1 Download the following upgrade ZIP bundle from the VMware Web site to a location that is accessible
to the vSphere CLI machine.

upgrade-from-ESXi4.0-to-4.1.0-0.0.build#-release.zip

The upgrade ZIP bundle contains and esxupdate bulletin and an upgrade bulletin.

2 Power off any virtual machines that are running on the host and place the host into maintenance mode.

3 Find out which bulletins are applicable to the ESX/ESXi host.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --scan --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --scan --bundle <local_path>/rollup.zip

The --server argument is the ESX/ESXi host name or IP address.

You can specify more than one bundle at the command line each time you run the command. For multiple
bundles, use a comma to separate the path and file name of the bundle. Do not include a space after the
comma.

4 (Optional) List all the bulletins that are available in the bundle.

n Search an offline HTTP server:

vihostupdate.pl --server <server> --list --bundle http://<webserver>/rollup.zip

n Search the local machine:

vihostupdate.pl --server <server> --list --bundle <local_path>/rollup.zip

This command lists all the bulletins contained in the bundle, even those that do not apply to the host.

5 Install bulletins from one or more bundles on the ESX/ESXi host.

n Install from an offline HTTP server. The following example installs both VMware bulletins and
bulletins made available by a partner.

vihostupdate.pl --server <server> --install --bundle 

http://<webserver>/rollup.zip,http://<webserver>/rollupPartner1.zip --bulletin 

bulletin1,bulletin2

n Install from the local machine. The following example installs both VMware bulletins and bulletins
made available by a partner.

vihostupdate.pl --server <server> --install --bundle 

<local_path>/rollup.zip,<local_path>/rollupPartner1.zip --bulletin bulletin1,bulletin2

If you omit the --bulletin argument, this command installs all the bulletins in the bundle.

6 Install the esxupdate bulletin by running the following command on the vSphere CLI machine.

vihostupdate --server host name or IP address -i -b location of the ESXi upgrade ZIP bundle -

B ESXi410-GA-esxupdate

7 Install the upgrade bulletin by running the following command on the vSphere CLI machine.

vihostupdate --server host name or IP address -i -b location of the ESXi upgrade ZIP bundle -

B ESXi410-GA
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8 Verify that the bulletins are installed on the ESXi host by running the following command.

vihostupdate.pl --server host name or IP address --query

9 (Optional) Remove individual bulletins.

vihostupdate.pl --server <server> --remove --bulletin bulletin1

Use this option only for removing bulletins that are third-party or VMware extensions. Do not remove
bulletins that are VMware patches or updates. vihostupdate can remove only one bulletin at a time.

10 Reboot the host.

Upgrade an ESX Host with the esxupdate Utility
You can use the esxupdate utility to upgrade from ESX 4.0 to ESX 4.1.

Prerequisites

The following space requirements for partitions must be met.

n The /root partition must have at least 1.8GB.

n The /boot partition must have at least 24MB of free space.

Procedure

1 Download the following upgrade ZIP bundles from the VMware Web site to a location that is accessible
to the host.

n The esxupdate bulletin, pre-upgrade-from-ESX4.0-to-4.1.0-0.0.build#-release.zip

n The upgrade bulletin, upgrade-from-ESX4.0-to-4.1.0-0.0.build#-release.zip

2 From the service console, log on to the ESX 4.0 host as user root.

If you do not have direct access to the ESX 4.0 host, connect remotely to the service console using ssh.

3 Power off any virtual machines that are running on the host and place the host into maintenance mode.

4 Run the following command to enable an outgoing connection for the service console.

esxcfg-firewall --allowIncoming --allowOutgoing

5 Install the esxupdate bulletin by running the following command.

esxupdate --bundle location of the esxupdate ZIP bundle update

6 Install the upgrade bulletin by running the following command.

esxupdate --bundle location of the ESX upgrade ZIP bundle update

7 Run the esxupdate query command to verify that the bulletins are installed on the ESX host.

8 Reboot the host.

9 Reset the service console firewall to high security by running the following command.

esxcfg-firewall --blockOutgoing
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Update an ESX/ESXi Host Using a Depot with the vihostupdate Utility
You can use the vihostupdate utility with bundles or with a depot. This topic describes the procedure using
depots.

Prerequisites

Before you can update or patch an ESX/ESXi host from the command line, you must have access to a machine
on which you can run the VMware vSphere Command-Line Interface (vSphere CLI). You can install the
vSphere CLI on a Microsoft Windows or Linux system or import the VMware vSphere Management Assistant
(vMA) virtual appliance onto your ESX/ESXi host. For information about importing or installing the vSphere
CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Power off any virtual machines that are running on the host and place the host into maintenance mode.

2 Scan the depot for bulletins that are applicable to the host:

vihostupdate.pl --server <server> --scan --metadata http://<webserver>/depot/metadata.zip

The --server argument is the ESX/ESXi host name or IP address.

Do not specify more than one ZIP file at the command line each time you run the command. If you specify
--metadata more than once, the command processes only the last file that was specified.

3 (Optional) List all bulletins in the depot at the metadata.zip file location:

vihostupdate.pl --list --metadata http://<webserver>/depot/metadata.zip

This command lists all the bulletins in the depot, even those that do not apply to the host.

4 Install bulletins in the depot on the host:

vihostupdate.pl --install --metadata http://<webserver>/depot/metadata.zip --bulletin 

bulletin1,bulletin2

If you omit the --bulletin argument, this command installs all the bulletins in the bundle.

5 Verify that the bulletins are installed on your ESX/ESXi host.

vihostupdate.pl --server <server> --query

6 (Optional) Remove individual bulletins.

vihostupdate.pl --server <server> --remove --bulletin bulletin1

Use this option only for removing bulletins that are third-party or VMware extensions. Do not remove
bulletins that are VMware patches or updates. vihostupdate can remove only one bulletin at a time.

7 Reboot the host.

Uninstall a Bundle from a Host
Use this procedure to uninstall bulletins that are third-party or VMware extensions.

Do not remove bulletins that are VMware patches or updates.

Prerequisites

Before you can uninstall an update or patch from an ESX/ESXi host from the command line, you must have
access to a machine on which you can run the VMware vSphere Command-Line Interface (vSphere CLI). You
can install the vSphere CLI on a Microsoft Windows or Linux system or import the VMware vSphere
Management Assistant (vMA) virtual appliance onto your ESX/ESXi host. For information about deploying or
installing the vSphere CLI, see the VMware vSphere Command-Line Interface Installation and Reference Guide.
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Procedure

1 Determine which bulletins are installed on your ESX/ESXi host.

vihostupdate.pl --server <server> --query

Note the bundle ID for the bundle to uninstall.

2 Run the vihostupdate command.

vihostupdate --server <server> --remove --bulletin <bulletin ID>

vihostupdate can remove only one bulletin at a time.
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Postupgrade Considerations for
Hosts 10

A host upgrade is not complete until you have ensured that the host management, configuration, and licensing
is in place.

After you upgrade an ESX/ESXi host, consider the following tasks:

n View the upgrade logs.

For ESXi, you can use the vSphere Client to export the log files, or you can find the upgrade log file
esxupdate.log at /locker/db on the host.

For ESX, you can find upgrade log files at /var/log/vmware/ on the host.

You can run the following service console commands to get version and patch information:

n vmware -v

n vmware -l

n esxupdate query

n If vCenter Server manages the host, you must reconnect the host to vCenter Server by right-clicking the
host in the vCenter Server inventory and selecting Connect.

n When the upgrade is complete, ESX/ESXi is in evaluation mode. Evaluation mode lasts for 60 days. You
must assign an upgraded license to your product within 60 days after the upgrade. Use the License Portal
and the vSphere Client to configure licensing.

n On the VMware Web site, log in to your account page to access the license portal. From the license portal,
upgrade your ESX/ESXi license. Use the vSphere Client to assign the upgraded license key to the ESX/ESXi
host.

n The host sdX devices might be renumbered after the upgrade. If necessary, update any scripts that
reference sdX devices.

n After the ESX/ESXi upgrade, you must convert LUN masking to the claim rule format. To do this, run the
esxcli corestorage claimrule convert command in the vSphere Command-Line Interface. This
command converts the /adv/Disk/MaskLUNs advanced configuration entry in esx.conf to claim rules with
MASK_PATH as the plug-in. See the vSphere Command-Line Interface Installation and Reference Guide.

n After the ESX/ESXi upgrade, 3rd-party agents are disabled but remain on the disk. To reenable them, you
must reinstall them. You can use the vihostupdate vSphere CLI command to install 3rd-party extensions.
See the Installation Guide or the Setup Guide.

NOTE   After upgrading to ESX 4.1, only the Administrator user has access to the service console. To grant
service console access to other users after the upgrade, consider granting the Administrator permissions to
other users.
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This chapter includes the following topics:

n “Restore vSphere Web Access on ESX Hosts,” on page 82

n “Evaluation Period Countdown,” on page 83

n “Clean Up the ESX Bootloader Menu After Upgrade,” on page 83

n “About the esxconsole.vmdk,” on page 84

n “Uninstalling the VMware License Server,” on page 84

n “Roll Back an ESX Upgrade,” on page 85

n “Roll Back an ESXi Upgrade,” on page 85

n “Restore the ESX Host Configuration,” on page 86

n “Restore the ESXi Host Configuration,” on page 86

Restore vSphere Web Access on ESX Hosts
For ESX 3.5 to ESX 4.1 upgrades only, the vSphere Web Access service is disabled after you upgrade using
Update Manager. If you have Web Access enabled on the host, you must restore the service after the upgrade
is complete.

vSphere Web Access is a user interface that runs in a Web browser and provides access to the virtual machine’s
display. The vSphere Web Access service is installed when you install ESX 4.1 or vCenter Server 4.1, but is not
running by default. Before you log in and start managing virtual machines, you must start the vSphere Web
Access service on the ESX or vCenter Server instance.

NOTE   vSphere Web Access is not supported on ESXi hosts. Restoring Web Access is not applicable to upgrades
from ESX 4.0 to ESX 4.1.

Prerequisites

You must have root privileges to check the status and run the vSphere Web Access service.

Procedure

1 Log in to the ESX host using root privileges.

2 Type the command to check whether the Web Access service is running.

service vmware-webAccess status

A message appears that says whether the service is running.

3 (Optional) If vSphere Web Access is not running, type the command to start Web Access.

service vmware-webAccess start

What to do next

You can now use vSphere Web Access to log in to the ESX host. See the vSphere Web Access Administrator's
Guide.
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Evaluation Period Countdown
The ESX/ESXi 60-day evaluation period begins to count down immediately after the first time you power on
the ESX/ESXi machine.

The 60-day evaluation count down starts even if the host is licensed and you are not using evaluation mode.
For example, suppose you decide 10 days after the first power-on to switch from licensed mode to evaluation
mode. Only 50 days remain of the evaluation period. Sixty days after the first power-on, it is too late to switch
to evaluation mode because zero days remain of the evaluation period. During the evaluation period, if you
switch the ESX/ESXi machine from evaluation mode to licensed mode, the evaluation timer does not stop
counting down.

To prevent losing the availability of the evaluation mode, VMware recommends that before (or shortly after)
you power on your ESX/ESXi machine for the first time, decide whether you want to use evaluation mode.
One advantage of using evaluation mode is that it offers full feature functionality, which lets you try features
that you might not have yet without paying additional license costs.

Clean Up the ESX Bootloader Menu After Upgrade
After you determine that the ESX 4.1 upgrade is stable, you can remove the ESX 3.5 boot option from the ESX 4.1
bootloader menu to disable the ability to roll back to ESX 3.5.

After you upgrade a host from ESX 3.5 to ESX 4.1, the ESX bootloader boots into ESX 4.1 by default, but retains
the option to boot into ESX 3.5. The ESX 3.5 boot option is useful if the ESX 4.1 upgrade does not work as
expected in your environment. However, after you confirm that the upgrade is stable, you might want to
disable the ability to roll back to ESX 3.5.

This procedure is applicable only if you left the default rollback option enabled when you performed the
upgrade. If you deselected the rollback option, this procedure is not applicable. Only a system administrator
can perform this optional procedure.

Prerequisites

Before executing this script, make sure that you have copied all required data from the legacy ESX mount
points under /esx3-installation.

Procedure

1 In the ESX 4.1 service console, run the cleanup-esx3 command with the optional -f (force) flag.

If you omit the -f flag, the software prompts you to confirm that you want to disable the ability to roll
back to the ESX 3.5.

2 (Optional) Reboot the host.

While the server is powering on, observe that the bootloader menu does not include an option for ESX
3.5.

The host looks the same as a clean installation of ESX 4.1. The cleanup-esx3 script removes the following files
and references from the ESX 4.1 host:

n ESX 3.5 references in the /etc/fstab directory

n ESX 3.5 boot files in the /boot directory

n The rollback-to-esx3 script in the /usr/sbin/ directory
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About the esxconsole.vmdk
A virtual machine disk file (.vmdk file) stores the contents of a virtual machine's hard disk drive. A .vmdk file
can be accessed in the same way as a physical hard disk.

In ESX 4.1, the service console's partitions are stored in a .vmdk file. These partitions include /,
swap, /var/log, and all the optional partitions. The name of this file is esxconsole-system-
uuid/esxconsole.vmdk. All .vmdk files, including the esxconsole.vmdk, are stored in VMFS volumes.

CAUTION   Do not change the name or directory path of the esxconsole.vmdk file. If you rename the esxconsole
folder or the VMDK file, the ESX host cannot reboot. VMware recommends that you allow only administrators
to modify datastores and make certain that users who have permission to modify datastores are aware of the
problems that occur when the esxconsole-system-uuid folder or the esxconsole.vmdk file is renamed.

The esxconsole-system-uuid folder contains the following files and subdirectories:

n esxconsole-flat.vmdk

n esxconsole.vmdk

n core-dumps

n logs

n logs/sysboot-vmkernel-boot.log

n logs/sysboot-dmesg-boot.log

n logs/sysboot-vmkernel-late.log

n logs/sysboot-dmesg-late.log

n logs/sysboot.log

IMPORTANT   The service console must be installed on a VMFS datastore that is resident on a host's local disk or
on a SAN disk that is masked and zoned to that particular host only. The datastore that contains
esxconsole.vmdk cannot be shared between hosts.

Uninstalling the VMware License Server
After you upgrade all of your hosts to ESX 4.1/ESXi 4.1, you can optionally uninstall your license server and
remove the license server configuration from vCenter Server.

NOTE   Consider leaving the license server and the license server configuration in place if the vCenter Server
instance might need to manage ESX 3.x/ESXi 3.5 hosts in the future. The license server does not interfere with
operations if you leave it in place.

Procedure

1 As Administrator on the Microsoft Windows system, select Start > Settings > Control Panel >
Add/Remove Programs.

2 Select the VMware License Server and click Remove.

3 Click Yes to confirm that you want to remove the program and click Finish.

4 In vCenter Server, select Administration > vCenter Server Settings.

5 In the License Server text box, delete the path to the license server.

6 If the Reconfigure ESX 3 hosts using license servers to use this server option is selected, unselect it.
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7 Click OK.

Roll Back an ESX Upgrade
You might need to roll back to ESX 3.5 if the upgrade to ESX 4.1 does not work as expected in your environment.
Optionally, you can remove the ESX 4.1 boot option from the ESX bootloader menu and perform a complete
roll back to ESX 3.5.

NOTE   Roll backs are supported only for upgrades from ESX 3.5 to ESX 4.1 using vCenter Update Manager.

Consider the following points:

n Any changes made to the ESX 4.1 service console are lost after the rollback.

n Any changes made to virtual machines will persist after the rollback.

n If you upgraded the virtual machine hardware, the virtual machines will not work after you perform the
ESX rollback. To avoid this situation, take a snapshot of the virtual machine before you upgrade the virtual
machine hardware. After you run the ESX rollback script, boot into ESX 3.5 and revert to the snapshot.

n Only a system administrator can perform this optional procedure.

Procedure

1 Run the rollback-to-esx3 command in the ESX 4.1 service console.

The rollback-to-esx3 command reconfigures the bootloader to boot into ESX 3.5 and removes the ability
to boot into ESX 4.1.

You can include the optional -f (force) flag. If you omit the -f flag, you are prompted to confirm that you
want to roll back to ESX 3.5.

2 Reboot the server.

While the host is powering on, observe that the boot menu has changed to ESX 3.5.

3 After the host boots into ESX 3.5, delete the ESX 4.1 service console VMDK folder from the VMFS datastore.

The service console VMDK folder name has the following format: esxconsole-<UUID>.

Roll Back an ESXi Upgrade
Each time you update an ESXi host, a copy of the ESXi image is saved on your host. If you think an ESXi upgrade
might be making your host not work as expected in your environment, you can roll back the upgrade.

ESXi permits only one level of rollback. Only one previous build can be saved at a time. In effect, each ESXi 4.x
host stores up to two builds, one boot build and one standby build.

When you manually boot into the standby build instead of the current boot build, an irreversible rollback
occurs. The standby build becomes the new boot build and remains the boot build until you perform another
update.

Procedure

1 Reboot the ESXi 4.1 host.

2 When the page that displays the current boot build appears, press Shift+r to select the standby build.

3 Press Shift+y to confirm the selection and press Enter.

The previous upgrade rolls back. The standby build becomes the boot build.
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Restore the ESX Host Configuration
If you backed up your ESX service console and VMFS files, you can restore your original ESX host configuration.

Procedure

1 Reinstall the original version of ESX on the host. See the Installation Guide.

2 Restore the backed-up service console and local VMFS files.

See http://www.vmware.com/resources/techresources/610.

Restore the ESXi Host Configuration
If you created a backup of the ESXi host configuration, you can restore the configuration.

To restore a configuration on a host, you must run the vSphere CLI virtual appliance from a remote host. When
you restore the configuration, the target host must be in maintenance mode, which means all virtual machines
(including the vSphere CLI virtual appliance) must be powered off.

For more information, see the ESXi and vCenter Server Setup Guide.

For more information about the VMware vSphere Command-Line Interface and the vicfg-cfgbackup
command, see the vSphere Command-Line Interface Installation and Reference Guide.

Procedure

1 Restore the ESXi software.

n Reinstall the ESXi Installable software by using the Installation CD.

n Recover the ESXi Embedded software by using the Recovery CD.

2 Install the vSphere CLI.

3 In the vSphere CLI, run the vicfg-cfgbackup command with the -l flag to load the host configuration
from a specified backup file.
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Upgrading Virtual Machines 11
After you perform an ESX/ESXi upgrade, VMware recommends that you upgrade all the virtual machines that
reside on the host.

The first step in upgrading virtual machines is to upgrade VMware Tools. If the virtual machines do not have
VMware Tools installed, you can use the VMware Tools upgrade procedure to install VMware Tools. After
you install or upgrade VMware Tools, upgrade the virtual machine hardware.

VMware offers the following tools for upgrading virtual machines:

vSphere Client Requires you to perform the virtual machine upgrade one step at a time.

vCenter Update Manager Automates the process of upgrading and patching virtual machines, thereby
ensuring that the steps occur in the correct order. You can use vCenter Update
Manager to directly upgrade virtual machine hardware, VMware Tools, and
virtual appliances. You can also patch and update third-party software running
on the virtual machines and virtual appliances. See the VMware vCenter Update
Manager Installation and Adminstration Guide accessible on the VMware vCenter
Update Manager Documentation page: 
http://www.configuresoft.net/support/pubs/vum_pubs.html:

NOTE   Do not use vmware-vmupgrade.exe to upgrade virtual machines.

This chapter includes the following topics:

n “About VMware Tools,” on page 88

n “About Virtual Machines and ESX/ESXi Upgrades,” on page 88

n “Orchestrated Upgrade of Virtual Machines Scenario,” on page 88

n “Planning Downtime for Virtual Machines,” on page 89

n “Downtime for Upgrading Virtual Machines,” on page 89

n “Perform an Interactive Upgrade of VMware Tools on a Microsoft Windows Guest,” on page 90

n “Perform an Interactive Upgrade of VMware Tools on a Linux Guest with the Tar Installer,” on
page 91

n “Perform an Interactive Upgrade of VMware Tools on a Solaris Guest,” on page 92

n “Perform an Interactive Upgrade of VMware Tools in a Netware Virtual Machine,” on page 93

n “Perform an Automatic Upgrade of VMware Tools,” on page 94

n “Upgrade VMware Tools on Multiple Virtual Machines,” on page 95

n “Configure a Virtual Machine to Automatically Upgrade VMware Tools,” on page 96
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n “Upgrade Virtual Hardware,” on page 96

n “Upgrade Virtual Hardware on Multiple Virtual Machines,” on page 98

About VMware Tools
VMware Tools is a suite of utilities that enhances the performance of the virtual machine’s guest operating
system and improves management of the virtual machine.

Although the guest operating system can run without VMware Tools, you lose important functionality and
convenience. If you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown
or restart options from the toolbar. You can use only the power options. Shut down the guest operating system
from the virtual machine console before you power off the virtual machine.

The installers for VMware Tools for Microsoft Windows, Linux, Solaris, and NetWare guest operating systems
are built into ESX/ESXi as ISO image files. An ISO image file looks like a CD-ROM to your guest operating
system and even appears as a CD-ROM disc. You do not use an actual CD-ROM disc to install VMware Tools,
nor do you need to download the CD-ROM image or burn a physical CD-ROM of this image file.

When you install VMware Tools, VMware vCenter Server temporarily connects the virtual machine’s first
virtual CD-ROM disk drive to the ISO image file that contains the VMware Tools installer for your guest
operating system. You are ready to begin the installation process.

When you upgrade VMware Tools, the software completely uninstalls and reinstalls the VMware Tools
package. For this reason, some functionality such as networking might temporarily stop working in the middle
of the upgrade procedure. The functionality is restored at the end of the upgrade procedure.

About Virtual Machines and ESX/ESXi Upgrades
Some virtual machines that you create on ESX 4.x/ESXi 4.x hosts are supported on ESX 3.x/ESXi 3.5 hosts.

If you create a virtual machine on ESX 4.x/ESXi 4.x and select the typical path, the virtual hardware version is
version 7. Virtual machines with virtual hardware version 7 are not supported on ESX 3.x/ESXi 3.5 hosts. When
you create virtual machines on ESX 4.x/ESXi 4.x, select the custom path and select virtual hardware version 4
to ensure that your virtual machines can run on ESX 3.x/ESXi 3.5 hosts. When the virtual machines have virtual
hardware version 4, you can migrate the virtual machines between the ESX 3.x/ESXi 3.5 and ESX 4.x/ESXi 4.x
hosts and use vMotion.

If you create virtual machines that use paravirtualization (VMI) or an enhanced networking device (vmxnet),
vMotion is not supported. In this case, you can move the virtual machine to the ESX 3.x host if the virtual
machine is powered off. Virtual machines that you create on ESX 4.x/ESXi 4.x hosts are not supported on
ESX 2.x hosts.

Orchestrated Upgrade of Virtual Machines Scenario
An orchestrated upgrade allows you to upgrade VMware Tools and the virtual hardware of the virtual
machines in your vSphere inventory at the same time. You can perform an orchestrated upgrade of virtual
machines at the folder or datacenter level.

Update Manager makes the process of upgrading the virtual machines convenient by providing baseline
groups. When you remediate a virtual machine against a baseline group containing the
VMware Tools Upgrade to Match Host baseline and the VM Hardware Upgrade to Match Host baseline,
Update Manager sequences the upgrade operations in the correct order. As a result, the guest operating system
is in a consistent state at the end of the upgrade.
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Planning Downtime for Virtual Machines
Plan downtime for each virtual machine during the upgrade process. Typically, this downtime occurs during
the virtual machine upgrade and the VMware Tools upgrade. Depending on your upgrade plan, some virtual
machine downtime might be required during the ESX upgrade.

If an ESX/ESXi host is not managed by vCenter Server, you cannot use vMotion to move virtual machines. The
virtual machines must have some downtime when the ESX/ESXi host reboots after upgrade.

You might not have to shut down more than a single virtual machine at any given time. You can stagger virtual
machine downtimes to accommodate a schedule convenient to you and your customers.

For example:

n If your virtual machine users are located in diverse time zones, you can prepare by migrating virtual
machines to specific hosts to serve a given time zone. This way you can arrange host upgrades so that
virtual machine downtime occurs transparently outside business hours for that time zone.

n If your virtual machine users operate around the clock, you can delay downtime for their virtual machines
to normally scheduled maintenance periods. You do not need to upgrade any stage within a certain time
period. You can take as long as needed at any stage.

Downtime for Upgrading Virtual Machines
When you upgrade virtual machines, the required downtime varies depending on the guest operating system.

The following procedures are involved in upgrading virtual machines:

n Upgrade VMware Tools

n Upgrade virtual hardware

During the VMware Tools upgrade, the virtual machine remains powered on. For Microsoft Windows
operating systems, you must reboot the guest operating system at the end of the VMware Tools upgrade
procedure. For Linux, Netware, and Solaris guest operating systems, no reboot is required at the end of the
procedure.

When you upgrade VMware Tools, expect downtime as follows:

n No downtime is required for vCenter Server.

n No downtime is required for ESX/ESXi hosts.

n You must reboot Microsoft Windows virtual machines at the end of the upgrade procedure, or later, to
make the upgrade take effect.

n On Windows guest operating systems, you must reboot the virtual machine a total of three times when
you upgrade VMware Tools and the virtual hardware:

a Power on the virtual machine.

b Upgrade VMware Tools.

c Reboot the virtual machine at the end of the VMware Tools upgrade.

d Power off the virtual machine.

e Upgrade the virtual Hardware.

f Power on the virtual machine.

g The Windows operating system detects new devices and prompts you to reboot the virtual machine.

h Reboot the virtual machine to make the devices work properly.

During the virtual hardware upgrade, the virtual machine must be shut down for all guest operating systems.
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Table 11-1 summarizes the downtime required by guest operating system and by upgrade operation.

Table 11-1.  Virtual Machine Downtime by Guest Operating System

Guest Operating System Upgrade VMware Tools Upgrade Virtual Hardware

Linux No downtime Downtime for shut down and power on of
virtual machine

Netware No downtime Downtime for shut down and power on of
virtual machine

Solaris No downtime Downtime for shut down and power on of
virtual machine

Microsoft Windows Downtime for reboot of guest
operating system

Downtime for shut down and power on of
virtual machine

Perform an Interactive Upgrade of VMware Tools on a Microsoft
Windows Guest

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See the Virtual Machine Administration Guide.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 If the Microsoft Windows New Hardware wizard appears in the virtual machine console, complete the
wizard and accept the defaults.

Upgrading virtual hardware and installing or upgrading VMware Tools includes enhancements to the
virtual network adapter. A Microsoft Windows guest operating system might interpret these changes as
indicating a different network adapter in the virtual machine and start the New Hardware wizard
accordingly.

7 In the virtual machine console, do one of the following:

n If autorun is enabled, click OK to confirm that you want to install VMware Tools and start the
InstallShield wizard.

n If autorun is not enabled, manually start the VMware Tools installer, by clicking Start > Run and
entering D:\setup.exe, where D: is your first virtual CD-ROM drive.
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8 Follow the onscreen instructions.

9 Reboot to make the changes take effect.

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Linux Guest with
the Tar Installer

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See the Virtual Machine Administration Guide.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, log in as root (su -) and, if necessary, create the /mnt/cdrom directory:

mkdir /mnt/cdrom

7 Mount the VMware Tools virtual CD-ROM image.

Some Linux distributions automatically mount CD-ROMs. Verify the state by running the mount
command. If the CD-ROM device is mounted, each of the device's partitions with a recognized file system
appears in the output of the mount command as something like this:

/dev/cdrom on /mnt/cdrom type iso9660 (ro,nosuid,nodev)

If the CD-ROM device is listed, it is mounted. If the CD-ROM device is already mounted, do not use the
mount and umount commands.

Some Linux distributions use different device names or organize the /dev directory differently. Modify
the following commands to reflect the conventions used by your distribution:

mount /dev/cdrom /mnt/cdrom

8 Change to a working directory (for example, /tmp):

cd /tmp
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9 If you have a previous installation, delete the previous vmware-tools-distrib directory:

rm -rf /tmp/vmware-tools-distrib

The default location of this directory is: /tmp/vmware-tools-distrib.

10 List the contents of the /mnt/cdrom/ directory, and note the filename of the VMware Tools tar installer:

ls /mnt/cdrom

11 Uncompress the tar installer, where <xxxxxx> is the build or revision number of the ESX/ESXi version.

tar zxpf /mnt/cdrom/VMwareTools-4.0.0-<xxxxxx>.tar.gz

If you attempt to install a tar installation over an RPM installation, or the reverse, the installer detects the
previous installation and must convert the installer database format before continuing.

12 Unmount the CD-ROM image:

umount /dev/cdrom

13 Run the VMware Tools tar installer:

cd vmware-tools-distrib

./vmware-install.pl

14 Answer the prompts and press Enter to accept the default values if appropriate for your configuration
and follow the instructions at the end of the script.

15 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

16 (Optional) When the upgrade is complete, log off the root account:

exit

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools on a Solaris Guest
Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See the Virtual Machine Administration Guide.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.
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3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, log in as root (su -) and, if necessary, mount the VMware Tools virtual
CD-ROM image, as follows.

Usually, the Solaris volume manager mounts the CD-ROM under /cdrom/vmwaretools. If the CD-ROM is
not mounted, restart the volume manager using the following commands:

/etc/init.d/volmgt stop

/etc/init.d/volmgt start

7 After the CD-ROM is mounted, change to a working directory (for example, /tmp) and extract VMware
Tools:

cd /tmp

gunzip -c /cdrom/vmwaretools/vmware-solaris-tools.tar.gz | tar xf -

8 Run the VMware Tools tar installer:

cd vmware-tools-distrib

./vmware-install.pl

Respond to the prompts and press Enter to accept the default values.

9 Log off of the root account:

exit

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Interactive Upgrade of VMware Tools in a Netware Virtual
Machine

Upgrade VMware Tools to the latest version to enhance the performance of the virtual machine's guest
operating system and improve virtual machine management.

Prerequisites

n Back up your virtual machines to prevent data loss. See the Virtual Machine Administration Guide.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.
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4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

5 Select Interactive Tools Upgrade and click OK.

The upgrade process starts by mounting the VMware Tools bundle on the guest operating system.

6 In the virtual machine console, load the CD-ROM driver so the CD-ROM device mounts the ISO image
as a volume.

7 Select Novell > Utilities > Server Console to open the Netware Server Console, and enter one of the
following commands:

n In the NetWare 6.5 Server Console, enter: LOAD CDDVD.

n In the NetWare 6.0 or NetWare 5.1 Server Console, enter: LOAD CD9660.NSS.

8 In the Server Console, enter the following command:

vmwtools:\setup.ncf

9 Check the VMware Tools label on the virtual machine Summary tab.

The VMware Tools label should say OK.

When the installation finishes, the message VMware Tools for NetWare are now running appears in the Logger
Screen (NetWare 6.5 and NetWare 6.0 guests) or the Console Screen (NetWare 5.1 guests).

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Perform an Automatic Upgrade of VMware Tools
When you start an automatic upgrade of VMware Tools, you do not need to perform any operations in the
guest operating system that is running on the virtual machine. The automatic upgrade uninstalls the previous
version of VMware Tools, installs the latest version that is available for your ESX/ESXi host, and if necessary,
reboots the virtual machine.

Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or NetWare guest
operating systems.

Prerequisites

You must have the following items before you perform an automatic upgrade:

n Back up your virtual machines to prevent data loss. See the Virtual Machine Administration Guide.

n A supported guest operating system must be installed on the virtual machine.

n You must have an ESX/ESXi license or be using evaluation mode to power on the virtual machine.

Procedure

1 From the vSphere Client, right-click the virtual machine, select Power, and select Power On.

2 Select the virtual machine and click the Summary tab.

The VMware Tools label indicates whether VMware Tools is installed and current, installed and not
current, or not installed.

3 Click the Console tab to make sure that the guest operating system starts successfully, and log in if
necessary.

Wait until the guest operating system starts.
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4 Right-click the virtual machine, select Guest, and select Install/Upgrade VMware Tools.

If the guest operating system has an out-of-date version of VMware Tools, the Install/Upgrade Tools dialog
box appears.

5 Select Automatic Tools Upgrade.

6 (Optional) For Microsoft Windows guest operating systems only, specify a location for the log file by
entering values in the Advanced Options field.

Option Description

Microsoft Windows Guest Operating
Systems

Enter /s /v "/qn" /l
"Microsoft_Windows_location\filename.log" to perform a silent
upgrade of VMware Tools and create a log file in the specified location on
the guest operating system.

Linux Guest Operating Systems n Enter --default to perform the default behavior. Perform a silent
upgrade of VMware Tools. Install tools bin, lib and doc files in the
default /usr directory.

n Enter --prefix=binary_location,lib_location,doc_location to
perform a silent upgrade of VMware Tools and install the binary, library,
and document files in the specified locations.

 
7 Click OK.

8 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Upgrade VMware Tools on Multiple Virtual Machines
You can upgrade VMware Tools on multiple virtual machines by using the Virtual Machines tab.

Prerequisites

Create backups or snapshots of the virtual machines. See the vSphere Virtual Machine Administration Guide.

Procedure

1 Start the vSphere Client and log in to the vCenter Server.

2 Select Inventory > Hosts and Clusters.

3 Select the host or cluster that contains the virtual machines to upgrade.

4 Click the Virtual Machines tab.

5 Select the virtual machines to upgrade and power them on.

6 Right-click your selections, select Guest > Install/Upgrade VMware Tools and click OK.
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7 For Linux guest operating systems, execute the following commands to restore the network:

/etc/init.d/network stop

rmmod vmxnet

modprobe vmxnet

/etc/init.d/network start

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7. See “Upgrade Virtual Hardware on
Multiple Virtual Machines,” on page 98.

Configure a Virtual Machine to Automatically Upgrade VMware Tools
You can configure a virtual machine to check for and apply VMware Tools upgrades each time you power on
the virtual machine.

Automatic VMware Tools upgrade is not supported for virtual machines with Solaris or Netware guest
operating systems.

Prerequisites

n Back up your virtual machines to prevent data loss. See the vSphere Virtual Machine Administration Guide.

n Virtual machines must have a version of VMware Tools shipped with ESX 3.0.1 or later installed.

n Virtual machines must be hosted on an ESX 3.0.1 or later, and VirtualCenter must be version 2.0.1 or later.

n Virtual machines must be running a Linux or Microsoft Windows guest operating system that is supported
by ESX 3.0.1 or later and VirtualCenter 2.0.1 or later.

Procedure

1 Power off the virtual machine.

2 Right-click the virtual machine and select Edit Settings.

3 On the Options tab, select VMware Tools.

4 In the Advanced pane, select Check and upgrade Tools before each power-on and click OK.

The next time you power on the virtual machine, it checks the ESX/ESXi host for a newer version of VMware
Tools. If a newer version is available, it is installed and the guest operating system is restarted (if required).

The VMware Tools label on the Summary tab changes to OK.

What to do next

(Recommended) Upgrade the virtual machine hardware to version 7.

Upgrade Virtual Hardware
You can upgrade the hardware version of virtual machines to the latest version of ESX/ESXi. For virtual
machines that are running on ESX 4.x/ESXi 4.x, VMware recommends that you upgrade the virtual hardware
to version 7.

Consider the following points:

n When you upgrade from virtual hardware version 3 to version 7, the upgrade is irreversible, even if you
take a virtual machine backup or snapshot before performing the upgrade. When you upgrade from virtual
hardware version 4 to version 7 the upgrade is reversible if you take a virtual machine backup or snapshot
before performing the upgrade.
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n Upgraded virtual machines cannot be powered on by an ESX 2.x host, even if relocated to a VMFS2
datastore.

n To automate this process, consider using vCenter Update Manager for virtual machine upgrades. vCenter
Update Manager takes automatic snapshots before performing virtual machine upgrades. See the vSphere
Update Manager Administration Guide.

n When you upgrade virtual hardware, no downtime is required for vCenter Server or ESX/ESXi hosts. For
virtual machines, the only significant downtime is the time to reboot the guest operating systems.

Prerequisites

n Create a backup or snapshot of the virtual machine. See the vSphere Virtual Machine Administration Guide.

n Upgrade VMware Tools.

n Make sure that all .vmdk files are available to the ESX/ESXi host on a VMFS3 datastore.

n Make sure that the virtual machine is stored on VMFS3 or NFS datastores.

n Make sure that no suspend files exist.

n Make sure that at least one virtual disk exists.

n Determine the version of the virtual hardware by selecting the virtual machine and clicking the
Summary tab. The VM Version label displays the virtual hardware version.

IMPORTANT   VMware recommends that before you upgrade the virtual hardware, first upgrade VMware Tools
on the virtual machine. This is especially important for virtual machines with Microsoft Windows guest
operating systems. On Microsoft Windows virtual machines, if you upgrade the virtual hardware before you
upgrade VMware Tools, the virtual machine might lose its network settings.

To automate this process, consider using vCenter Update Manager for virtual machine upgrades. vCenter
Update Manager ensures that upgrade procedures happen in the correct order. See the vSphere Update Manager
Administration Guide.

Procedure

1 Power off the virtual machine.

2 From the vSphere Client, right-click a virtual machine in the inventory and select Upgrade Virtual
Hardware.

The software upgrades the virtual hardware to the latest supported version.

The Upgrade Virtual Hardware option appears if the virtual hardware on the virtual machine is not the
latest supported version.

3 Click Yes to continue with the virtual hardware upgrade.

4 Power on the virtual machine.

If the virtual machine has a Microsoft Windows guest operating system, the operating system detects a
new device, configures the device, and prompts you to reboot the guest operating system. If any unknown
devices are recognized, the operating system prompts you to configure the device manually.

5 For Windows guest operating systems, reboot the guest operating system to make the changes take effect.

The virtual hardware version is 7 on the VM Version label on the virtual machine Summary tab.
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Upgrade Virtual Hardware on Multiple Virtual Machines
You can upgrade virtual hardware on multiple virtual machines by using the Virtual Machines tab.

Prerequisites

n Create backups or snapshots of the virtual machines. See the vSphere Datacenter Administration Guide.

n Upgrade VMware Tools.

n Make sure that all .vmdk files are available to the ESX/ESXi host on a VMFS3 datastore.

n Make sure that the virtual machines are stored on VMFS3 or NFS datastores.

n Make sure that no suspend files exist.

n Make sure that at least one virtual disk exists for each virtual machine.

Procedure

1 Start the vSphere Client and log in to the vCenter Server.

2 Select Inventory > Hosts and Clusters.

3 Select the host or cluster that contains the virtual machines to upgrade.

4 Click the Virtual Machines tab.

5 Select the virtual machines to upgrade and power them off.

6 Right-click your selections, select Upgrade Virtual Hardware and click Yes.

7 Power on the virtual machines.

For Microsoft Windows guest operating systems, the operating system detects a new device, configures
the device, and prompts you to reboot the guest operating system. If any unknown devices are recognized,
the operating system prompts you to configure the device manually.

8 For Windows guest operating systems, reboot the guest operating system to make the changes take effect.

The virtual hardware version is 7 on the VM Version label on the virtual machine Summary tab.
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Example Upgrade Scenarios 12
Upgrade scenarios for vSphere 4.1 include cases with and without clustered hosts, hosts that you upgrade on
the same machine on which they are currently running (in-place upgrades), and hosts that you upgrade using
different machines (migration upgrades).

This chapter includes the following topics:

n “Upgrading Environments with Host Clusters,” on page 99

n “Upgrading Environments without Host Clusters,” on page 100

n “Moving Virtual Machines Using vMotion During an Upgrade,” on page 102

n “Upgrading by Moving Virtual Machines Using Upgrade vMotion,” on page 103

n “Moving Powered Off or Suspended Virtual Machines During an Upgrade (with vCenter Server),” on
page 105

n “Upgrading to vCenter Server on a New Machine,” on page 107

Upgrading Environments with Host Clusters
This example scenario shows how you can use vCenter Update Manager to simplify the host and virtual
machine upgrade process and minimize downtime in environments that include host clusters.

These are the prerequisites for this scenario:

n You must have VirtualCenter 2.5 or higher or vCenter Server 4.0.

n You must have vCenter Update Manager.

n All your hosts must be ESX 3.5/ESXi 3.5 or higher.

The following list of tasks provides a high-level overview of the upgrade process.

1 Upgrade vCenter Server 2.5 or higher to vCenter Server 4.1.

NOTE   Starting with vCenter Server 4.1 Update 1, you cannot upgrade vCenter Server from releases prior
to VirtualCenter Server 2.5 Update 6.

a Make sure your database is compatible with vCenter Server 4.1. See the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 28.

c Take a full backup of the vCenter Server database. See your database documentation.

d Back up the vCenter Server SSL certificates.
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The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines.

After the upgrade, the hosts are automatically connected to vCenter Server 4.1 if you select that option
during the upgrade process. VMware High Availability (HA) and VMware Distributed Resource
Scheduler (DRS) clusters are automatically reconfigured. (Check to ensure that the automatic
reconfiguration is successful. In some cases, you might need to reconfigure the clusters manually.)

vCenter Server 4.1 is supported only on 64-bit systems. The upgrade method you use depends on what
version of VirtualCenter or vCenter Server you are upgrading and on what system it is currently installed.
For a detailed description of the upgrade procedure, see Chapter 3, “Preparing for the Upgrade to vCenter
Server,” on page 25 and Chapter 4, “Upgrading to vCenter Server 4.1,” on page 37.

2 Run the vCenter Agent Preupgrade Check tool.

3 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the vSphere Client.
You must have the previous version of the vSphere Client to connect to previous versions of vCenter
Server and ESX/ESXi.

For a detailed description of the procedure, see “Upgrade the vSphere Client,” on page 52.

4 If your environment has vCenter Converter, upgrade it to the latest version.

5 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

6 Upgrade vCenter Update Manager to vCenter Update Manager 4.1.

7 Use vCenter Update Manager to upgrade ESX 3.5/ESXi 3.5 or higher hosts to ESX 4.1/ESXi 4.1.

vCenter Update Manager puts the host into maintenance mode before upgrading the host. The downtime
for the procedure depends on the network speed and the server boot time.

In case of upgrade failure, vCenter Update Manager supports rollback to the previous release.

For a detailed description of the procedure, see the vSphere Update Manager Administration Guide.

8 Use vCenter Update Manager to upgrade your virtual machines. vCenter Update Manager ensures that
the VMware Tools upgrade and the virtual hardware upgrade happen in the correct order to prevent loss
of your network connectivity. vCenter Update Manager also performs automatic backups of your virtual
machines in case you need to roll back after the upgrade. You can upgrade hosts in clusters without
powering off the virtual machines if Distributed Resource Scheduler is available for the cluster.

9 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using vCenter Server.

Upgrading Environments without Host Clusters
If you have standalone ESX 4.0/ESXi 4.0 hosts, you can use the command-line utility vihostupdate to upgrade
your hosts and the vSphere Client to upgrade your virtual machines. You can use the command-line utility
esxupdate to upgrade ESX 4.0 hosts.

This scenario assumes that you do not have host clusters and you do not have vCenter Update Manager. In
such a case, you might not have vCenter Server either. If you do have vCenter Server, the following process
can apply to your environment as well.
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The following list of tasks provides a high-level overview of the upgrade process.

1 If you have vCenter Server, upgrade vCenter Server 4.0 to vCenter Server 4.1.

a Make sure your database is compatible with vCenter Server 4.1. This release discontinues support for
some database versions and adds support for other database versions. See the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 28.

c Take a full backup of the vCenter Server 4.0 database. See your database documentation.

d Back up the vCenter Server 4.0 SSL certificates.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines.

After the upgrade, the hosts are automatically connected to vCenter Server 4.1 if you select that option
during the upgrade process.

For a detailed description of the upgrade procedure, see Chapter 3, “Preparing for the Upgrade to vCenter
Server,” on page 25 and Chapter 4, “Upgrading to vCenter Server 4.1,” on page 37.

2 Run the vCenter Agent Preupgrade Check tool.

3 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the vSphere Client.
You must have the previous version of the vSphere Client to connect to previous versions of vCenter
Server and ESX/ESXi.

For a detailed description of the procedure, see “Upgrade the vSphere Client,” on page 52.

4 If your environment has vCenter Converter, upgrade it.

5 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

6 Use the command-line utility vihostupdate to upgrade ESX 4.0/ESXi 4.0 hosts to ESX 4.1/ESXi 4.1.
Alternatively, use the command-line utility esxupdate to upgrade ESX 4.0 to ESX 4.1.

This procedure involves putting the host into maintenance mode before you upgrade the host. The
downtime for the procedure depends on the network speed and the server boot time.

In case of upgrade failure, the process supports rollback to the previous release.

For a detailed description of the procedure, see Chapter 9, “Upgrading to ESX 4.1 or ESXi 4.1,” on
page 71.

7 Use the vSphere Client to upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.1.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware.

You must upgrade the VMware Tools before you upgrade the virtual hardware.

8 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX/ESXi host and the virtual machines on the hosts.

Chapter 12 Example Upgrade Scenarios

VMware, Inc.  101



Moving Virtual Machines Using vMotion During an Upgrade
This scenario is known as a migration upgrade. The migration upgrade is a managed transition rather than a
strict upgrade. By using vMotion to move virtual machines directly from one production host to another
production host, you minimize downtime of the virtual machines.

The following example provides a high-level overview of the upgrade process in an environment with
ESX 3.5/ESXi 3.5 or higher and vCenter Server 4.1, using vMotion to migrate your running virtual machines
to ESX 4.1/ESXi 4.1. The hosts in your environment must be licensed for and able to use vMotion.

You can perform a migration upgrade without vMotion. The only difference is the amount of downtime for
the virtual machines.

A migration upgrade calls for sufficient resources to run the production environment partly on older hosts
and partly on upgraded hosts. Any required redundancies and safeguards must be available on both upgraded
and non-upgraded infrastructure during the transition.

Prerequisites

The requirements for a migration upgrade with vMotion are as follows:

n One or more machines meeting ESX 4.1/ESXi 4.1 requirements.

n Empty host storage sufficient to hold a portion of your production virtual machines. Ideally, the storage
should be large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines
on this extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, complete the following tasks:

1 Upgrade VirtualCenter 2.5 or vCenter Server 4.0 to vCenter Server 4.1.

a Make sure your database is compatible with vCenter Server 4.1. This release discontinues support for
some database versions and adds support for other database versions. See the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 28.

c Take a full backup of the vCenter Server 4.0 database. See your database documentation.

d Back up the vCenter Server 4.0 SSL certificates.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines.

After the upgrade, the hosts are automatically connected to vCenter Server 4.1 if you select that option
during the upgrade process. Your VMware High Availability (HA) and VMware Distributed Resource
Scheduler (DRS) clusters are automatically reconfigured. (Check to ensure that the automatic
reconfiguration is successful. In some cases, you might need to reconfigure the clusters manually.)

For a detailed description of the upgrade procedure, see Chapter 3, “Preparing for the Upgrade to vCenter
Server,” on page 25 and Chapter 4, “Upgrading to vCenter Server 4.1,” on page 37.

2 Run the vCenter Agent Preupgrade Check tool.

3 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the vSphere Client.
You must have the previous version of the vSphere Client to connect to previous versions of vCenter
Server and ESX/ESXi.

For a detailed description of the procedure, see “Upgrade the vSphere Client,” on page 52.

4 If your environment has vCenter Converter, upgrade it to the latest version.
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5 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

6 If your environment has vCenter Update Manager, upgrade it to the latest version.

Procedure

1 Use vMotion to evacuate the virtual machines from the ESX 3.5/ESXi 3.5 or higher host.

2 Upgrade to ESX 4.1/ESXi 4.1, or perform a fresh installation of ESX 4.1/ESXi 4.1.

3 Add the ESX 4.1/ESXi 4.1 host to vCenter Server.

4 Use vMotion to move the virtual machines that you evacuated from the ESX 3.5/ESXi 3.5 or higher host
before the upgrade.

For vMotion to work, the hosts must be managed by the same vCenter Server instance.

What to do next

1 Upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.1/ESXi 4.1.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware. vSphere 4.1 supports some earlier virtual hardware versions. See the
vSphere Datacenter Administration Guide.

Upgrade VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vSphere
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 11, “Upgrading Virtual Machines,” on page 87.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each host and the virtual machines on the hosts.

Upgrading by Moving Virtual Machines Using Upgrade vMotion
This scenario is known as a migration upgrade that includes datastore migration. The migration upgrade is a
managed transition rather than a strict upgrade. By using vMotion to move virtual machines directly from one
datastore to another datastore, you minimize downtime of the virtual machines.

The following example provides a high-level overview of the upgrade process in an environment with ESX 2.5.x
and VirtualCenter 1.4.x, using upgrade vMotion to migrate your running virtual machines to ESX 4.0. The
hosts in your environment must be licensed for and able to use vMotion.

You can perform a migration upgrade without vMotion. The only difference is the amount of downtime for
the virtual machines.

Upgrade vMotion (also known as vMotion with datastore relocation) is a special case in which you perform a
one-way vMotion. In this scenario, you move virtual disks from a VMFS 2 volume to a VMFS 3 volume.
Requirements include persistent-mode disks, a VMFS 2 volume that is visible to the ESX 4.0 host, and
compatible host CPUs.

NOTE   Upgrade vMotion is required if you have ESX 2.5.x hosts.
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The disadvantage of a migration upgrade is that this plan requires additional resources. A migration upgrade
calls for sufficient resources to run the production environment partly on older hosts and partly on upgraded
hosts. Any required redundancies and safeguards must be available on both upgraded and non-upgraded
infrastructure during the transition.

Prerequisites

The requirements for upgrade vMotion are as follows:

n One or more machines meeting ESX 4.0/ESXi 4.0 requirements.

n Empty host storage sufficient to hold a portion of your production virtual machines. Ideally, the storage
should be large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines
on this extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, complete the following tasks:

1 Install vCenter Server 4.0. You cannot upgrade VirtualCenter 1.4.x to vCenter Server 4.0. You must perform
a fresh installation.

For the supported operating systems, database types, and other prerequisites, see the Compatibility
Matrixes and the Installation Guide on the VMware vSphere documentation Web site.

2 Install the vSphere Client 4.0.

You can install the vSphere Client on the same machine with your previous version of the VI Client. You
must have the previous version of the VI Client to connect to previous versions of VirtualCenter and
ESX/ESXi.

For the supported operating systems and other prerequisites, see the Compatibility Matrixes and the
Installation Guide.

Procedure

1 Install ESX 4.0/ESXi 4.0.

2 Create a VMFS3 datastore with a capacity that is greater than or equal to the VMFS2 datastore on the
ESX 2.5.x host.

3 Add the ESX 4.0/ESXi 4.0 host to vCenter Server.

4 Remove the ESX 2.5.x host from VirtualCenter 1.4.x and add it to vCenter Server 4.0.

For upgrade vMotion to work, the ESX 2.5.x and ESX 4.0/ESXi 4.0 hosts must be managed by the same
vCenter Server.

5 Expose the VMFS2 volume to the ESX 4.0/ESXi 4.0 host.

Upgrade vMotion requires that both the VMFS2 and VMFS3 volume are visible to the ESX 4.0 host. VMFS2
volumes are read-only on ESX 4.0/ESXi 4.0 hosts.

6 Select a powered on virtual machine and migrate it.

Upgrade vMotion copies the disk from VMFS2 to VMFS3. This process takes a varying amount of time,
depending on the size of the disk and the IO load.

The hardware version of the virtual machines is automatically upgraded from version 3 to version 4.

What to do next

1 Optionally, upgrade the virtual machines further.

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.0./ESXi 4.0.
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b Power off the virtual machines and upgrade to the latest version of virtual hardware (version 7) to
take advantage of the new virtual hardware. vSphere 4.0 supports some earlier virtual hardware
versions. See the vSphere Virtual Machine Administration Guide.

The virtual machine upgrade process is different for ESX 4.0/ESXi 4.0. In earlier versions, you upgraded
the virtual hardware upgrade before you upgraded VMware Tools. For ESX 4.0/ESXi 4.0, you upgrade
VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the VMware
vSphere Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual
machines, see Chapter 11, “Upgrading Virtual Machines,” on page 87.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each ESX 2.5.x host and the virtual machines on the hosts.

Moving Powered Off or Suspended Virtual Machines During an Upgrade
(with vCenter Server)

This scenario is known as a cold migration upgrade. When you use cold migration to move virtual machines
from one host to another host, additional downtime is required for the virtual machines.

This scenario assumes that the hosts do not have vMotion capabilities.

Upgrades using cold migrations are useful for scenarios in which a multi-step upgrade is required, such as
upgrades from versions lower than ESX 3.5. Such upgrades require upgrading to ESX 3.5 and then upgrading
to ESX 4.1.

Prerequisites

The requirements for a cold migration upgrade are as follows:

n One or more machines meeting ESX 4.1/ESXi 4.1 requirements.

n Empty host storage sufficient to hold a portion of your production virtual machines. Ideally, the storage
should be large enough to hold all of the migrated virtual machines. A larger capacity for virtual machines
on this extra storage means fewer operations are required before all your virtual machines are migrated.

Before you begin this procedure, complete the following tasks:

1 Upgrade to vCenter Server 4.1.

a Make sure your database is compatible with vCenter Server 4.1. This release discontinues support for
some database versions and adds support for other database versions. See the vSphere Compatibility
Matrixes on the VMware vSphere documentation Web site.

b Make sure that you have the required permissions to perform this procedure. See “Database
Prerequisites,” on page 28.

c Take a full backup of the vCenter Server database. See your database documentation.

d Back up the vCenter Server SSL certificates.

The downtime required for this upgrade is based on the amount of data in the database. During this time,
you cannot perform provisioning operations, such as cloning or creating virtual machines.

After the upgrade, the hosts are automatically connected to vCenter Server 4.1 if you select that option
during the upgrade process. Your VMware High Availability (HA) and VMware Distributed Resource
Scheduler (DRS) clusters are automatically reconfigured. (Check to ensure that the automatic
reconfiguration is successful. In some cases, you might need to reconfigure the clusters manually.)
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For a detailed description of the upgrade procedure, see Chapter 3, “Preparing for the Upgrade to vCenter
Server,” on page 25 and Chapter 4, “Upgrading to vCenter Server 4.1,” on page 37.

2 Run the vCenter Agent Preupgrade Check tool.

3 Install the vSphere Client.

You can install the vSphere Client on the same machine with your previous version of the vSphere Client.
You must have the previous version of the vSphere Client to connect to previous versions of vCenter
Server and ESX/ESXi.

For a detailed description of the procedure, see “Upgrade the vSphere Client,” on page 52.

4 If your environment has vCenter Converter, upgrade it to the latest version.

5 If your environment has vCenter Guided Consolidation, complete the consolidation plan and then
upgrade it to the latest version.

6 If your environment has vCenter Update Manager, upgrade it to the latest version.

Procedure

1 Add the ESX 4.1/ESXi 4.1 host to vCenter Server 4.1.

2 Add the ESX 4.0/ESXi 4.0 hosts to vCenter Server 4.1.

3 Power off or suspend the virtual machines on the ESX 4.0/ESXi 4.0 hosts.

4 Move the virtual machines to the ESX 4.1/ESXi 4.1 hosts.

What to do next

1 Upgrade your virtual machines:

a If they are not already powered on, power on the virtual machines and upgrade to the latest version
of VMware Tools. This upgrade allows you to use the new features of ESX 4.1/ESXi 4.1.

b Power off the virtual machines and upgrade to the latest version of virtual hardware to take advantage
of the new virtual hardware. vSphere 4.1 supports some earlier virtual hardware versions. See the
vSphere Virtual Machine Administration Guide.

Upgrade VMware Tools before you upgrade the virtual hardware.

You can use either the vSphere Client or vCenter Update Manager to upgrade virtual machines. In a
clustered environment, VMware recommends that you use vCenter Update Manager . See the vSphere
Update Manager Administration Guide. If you are using the vSphere Client to upgrade virtual machines, see
Chapter 11, “Upgrading Virtual Machines,” on page 87.

2 Upgrade your product licenses:

a Either your new license keys are sent to you in email, or you get them using the license portal.

b Apply the new license keys to your assets using the vSphere Client (or vCenter Server if you have it).

You must perform these tasks for each host and the virtual machines on the hosts.
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Upgrading to vCenter Server on a New Machine
The vCenter Server installation media include a data migration tool that you can use to migrate configuration
information such as port settings, SSL certificates, and license information from the source vCenter Server
machine to the new machine. Instead of performing an in-place upgrade to vCenter Server, you might want
to use a different machine for your upgrade. If you are upgrading from a version of VirtualCenter or vCenter
Server installed on a 32-bit platform, you must use this method to upgrade to a 64-bit platform.

You can also use the data migration tool to migrate a SQL Server Express database installed by the vCenter
Server installer on the same machine as vCenter Server. If you use a different database installed on the vCenter
Server machine, you must back up and move the database manually to the new machine. If the database is
installed on a different machine from vCenter Server, you can leave the database in place and create a new
DSN on the destination machine to connect to it.

If VMware vCenter Update Manager or vCenter Orchestrator is installed on the same machine as vCenter
Server, you can use the data migration tool to migrate configuration data for these products. You can also use
the tool to migrate the vCenter Update Manager database if it is a SQL Server Express database installed on
the same machine as vCenter Update Manager and vCenter Server. You cannot use the data migration tool to
migrate the vCenter Orchestrator database. See the documentation for vCenter Update Manager and vCenter
Orchestrator for more information on upgrading these products.

The following process shows how the upgrade is done:

1 If you are not using a SQL Server Express database installed on the same machine as vCenter Server, create
a backup of the database.

2 Run the backup.bat script of the data migration tool on the source machine to create a backup of the
vCenter Server configuration.

3 Copy the configuration data to the destination machine. See “Back Up VirtualCenter or vCenter Server
Configuration with the Data Migration Tool,” on page 43.

4 If you are not using a SQL Server Express database installed on the same machine as vCenter Server, move
the database by performing one of the following procedures:

n Restore the database on the destination machine.

n Detach the database on the source machine, copy the database files to the destination machine, and
attach the database on the destination machine.

5 Run the install.bat script on the destination machine. This script launches the vCenter Server installer
and installs vCenter Server with the configuration settings backed up by the backup.bat script.

This process is described in detail in Chapter 5, “Upgrade to vCenter Server on a Different Machine and
Upgrade the Existing Database,” on page 39.
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